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Preface P

General Information 0

Purpose 0 CentreVu Visual Vectors User Guide, 585-215-868 is written primarily for the 
CentreVu Call Management System (CMS) administrator who has access to 
all areas on one or more CentreVu CMS server(s), and secondarily for 
auxiliary administrators and split/skill supervisors who have limited access 
(for example, to Vectors and Vector Directory Numbers).

This book specifically addresses the DEFINITY Enterprise Communications 
Server (ECS) functionality of CentreVu CMS. If you are implementing 
CentreVu CMS R3V6 server for the first time, you will have DEFINITY ECS 
R6. This call center configuration supports all of the functions accessible 
using CentreVu Visual Vectors software.

Where to begin

Read “Setting Up Your Call Center World” on page 2-1 to learn how to use 
the CentreVu Visual Vectors interface. If you are unfamiliar with the 
Automatic Call Distribution (ACD) feature, see  “ACD Basics” in the CentreVu 
CMS R3V6 Administration, 585-215-850, document.

Safety labels 0 Actions or inactions that may cause difficulties are labeled as follows:

Caution

Caution

Indicates that failure to take or avoid a specified action could result in 
loss of data.

Warning

Indicates that failure to take or avoid a specified action could result in 
physical harm to the operator or the equipment. 
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Document 
organization 0

The following table describes the contents of each chapter and appendix 
in this document.

Conventions used in 
this document 0

The following conventions are used throughout this document.

Product release

DEFINITY Enterprise Communications Server (ECS) is referred to as 
“ECS.” Unless otherwise noted, the term ECS refers to Release 6 or 
later. The functionality of earlier switch releases is noted if it differs from 
that of Releases 5 and 6. 

Document number

Lucent publication titles are followed by their document number. For 
example, See CentreVu Visual Vectors Installation & Getting Started, 
585-215-869 for more information. 

# Title Contents

1 Introduction Generally describes CentreVu 
Framework and Visual Vectors and 
includes things you should know before 
using the product. 

2 Setting Up Your Call 
Center World

Describes how to use the Navigator user 
interface to set up the objects in your 
Call Center World.

3 Using Framework and 
the Navigator

Describes the CentreVu Framework 
user interface, and tells you how to view 
objects and perform actions with the 
Navigator tool.

4 Using  the Vector 
Editor

Tells you how to use the Vector Editor to 
create new and edit existing vectors, as 
well as to attach comments, display and 
print vectors. 

5 Using the VDN 
Administration Wizard

Tells you how to use this wizard-based 
interface to assign VDNs to vectors and 
set Skill Preferences.

6 Troubleshooting Presents answers to frequently asked 
questions about installing and using
Visual Vectors software.
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Typography

Courier font designates input and output.

● Input is something you type into the user interface. For example, 
Type  x next to Printer, Terminal, or File. 

● Output is a character, word or phrase that the system generates. For 
example, Please wait for initialization .....

Italic font highlights references to file names and directories. For 
example, /cms. 

Related documents 0 There are many documents that can help you use CentreVu CMS to its 
maximum capability. The title and document number of the most 
important ones are listed here.

● CentreVu Visual Vectors Installation and Getting Started, 585-215-
869

● CentreVu CMS R3V6 Administration, 585-215-850

● Lucent Call Center Change Description, 585-215-853

● CentreVu CMS R3V6 Upgrades and Migration Issue 2, 585-215-856

● CentreVu CMS R3V6 Sun Ultra 5 Computers Hardware Installation, 
585-215-857

● CentreVu CMS R3V6 Sun Ultra 5 Computers Connectivity Diagram, 
585-215-858 

● CentreVu CMS R3V6 Hardware Maintenance and Troubleshooting, 
585-215-861

● CentreVu CMS R3V6 Sun Enterprise 3000 Computer Connectivity 
Diagram, 585-215-865 

● CentreVu CMS R3V6 Sun Enterprise 3000 Computer Hardware 
Installation, 585-215-867 

● CentreVu CMS R3V6 Planning, Configuration, and Implementation, 
585-215-879

● Lucent Call Center Documentation CD-ROM, 585-215-892.



  
Preface CentreVu® Visual Vectors Version 1.0 User Guide

P-4



  
Introduction CentreVu® Visual Vectors Version 1.0 User Guide

1-1

Introduction 1

Overview 1

1 CentreVu Visual Vectors User Guide,  gives you the information you need to 
use the client software package.

This introduction is divided into several main sections:

● “General Information” presents a brief overview of what the software 
does, who uses it, and how it works, followed by an overview of 
supporting hardware and software. 

● “Things to Know Before Using Framework and Visual Vectors” 
describes the interactions with other call center client software.

● “Terminology” provides a list of key terms. A more extensive list of 
definitions appears in the glossary.

● “Things to Know About Call Center Data” describes common call center 
items, such as types of entities, data containers, and items.

● “Prerequisite System Administration” describes any system-level 
administration needed to run the client software, including permissions.
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General Information 1

Overview 1

1 CentreVu CMS/Visual Vectors software are products used by businesses 
and organizations that have a Lucent Technologies telecommunications 
Enterprise Communications Server (ECS) or switch and receive a large 
volume of telephone calls that are processed through the Automatic Call 
Distribution (ACD) and Call Vectoring features of the switch. CentreVu 
CMS collects call-traffic data, formats management reports, and provides 
an administrative interface to the ACD feature on the switch. See  “ACD 
Basics” in the CentreVu CMS R3V6 Administration, 585-215-850, 
document for more information.

The CentreVu CMS administrator can access the CentreVu CMS 
database, generate CMS reports, administer ACD parameters, and also 
monitor call activities to determine the most efficient service possible for 
the calling customers. The CentreVu CMS server supports CentreVu 
Supervisor client PCs.

The Visual Vectors Server software runs on the same platform as 
CentreVu CMS and supports CentreVu Visual Vectors clients. Using the 
client software, administrators can change certain properties of call 
center entities (such as their names), as well as create and edit vectors, 
assign VDNs to vectors, and set VDN Skill Preferences.

CentreVu CMS/Visual Vectors Server interfaces with the Solaris 
operating system and uses several Solaris system utilities to:

● communicate with CMS terminals and printers

● communicate with PCs running CentreVu Supervisor and CentreVu 
Visual Vectors client software

● log errors

● execute processes.  

In this section 1 This section introduces you to:

● Supported hardware platforms

● Required software

● Supported switch releases and features.
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Platforms and Required Software 1

Supported server 
hardware platforms 1

CentreVu CMS R3V6/Visual Vectors Server 1.0 software is certified to 
run on the following computers:

● Sun Enterprise 3000

● Sun Enterprise 3500

● Sun Ultra 5

● Sun SPARCserver 20

● Sun SPARCserver 10

● Sun SPARCserver 5.

CentreVu CMS running on the Sun SPARCserver 5 platform supports a 
combination of up to 128 terminals and printers. CentreVu CMS running 
on the Sun SPARCserver 10 or Sun SPARCserver 20 platforms or the 
Sun Enterprise 3000 or Sun Enterprise 3500 platforms supports a 
combination of up to 256 terminals and printers.

Recommended Client 
PC configuration 1

The recommended PC configuration required for CentreVu Visual 
Vectors 1.0 client software is the following:

● Pentium or compatible processor, running at 200 MHz or faster (the 
minimum supported processor speed is 133MHz, however 
performance may be unsatisfactory)

● A hard disk drive with 50 MB of free space before installation.

● A CD-ROM drive (not needed if you have network installation 
capability)

● 64 MB or more of RAM (the minimum supported amount of physical 
memory is 48MB). If simultaneous instances of Visual Vectors 
software’s tool windows are running, additional memory may be 
required to maintain acceptable performance.

● A video monitor and adapter set to at least 800x600x256 colors 

● Windows 95, Windows 98, or Windows NT 4.0 (with Service Pack 3 
or later) operating system

Note: The required browser for CentreVu Visual Vectors on-line help 
system is Microsoft Internet Explorer  3.02 or later. Before installing 
CentreVu Visual Vectors, ensure that Microsoft Internet Explorer  
3.02 or later is correctly installed; however, it does not need to be 
set as your default browser or .htm application.
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● A mouse or other pointing device compatible with one of the 
supported Windows operating systems

● For Network Connection:

— WinSock 1.1 compliant TCP/IP stack

— Ethernet communications board.

● For Modem Connection:

—  At least a 19.2 Kbps modem (If the modem is external, then 
the cable must be correctly wired to support hardware flow 
control.)

—  A 16550A UART communications port (or better)

— Dial-up networking, correctly configured using PPP (point-to-
point protocol) connectivity.

Required software for 
a Sun server platform 1

CentreVu CMS/Visual Vectors Server requires the following software 
packages to operate properly:

● An appropriate load of CentreVu CMS R3V6 (see your server 
documentation for the supported loads)

● An appropriate release of the Supplemental Services CD, Version 
1.0

● Solaris 2.5.1.

● Sun Common Desktop Environment 1.0.2

● SunLink X.25 Network Interface 9.1 (if using an X.25 connection to 
the switch)

● 1.0 Network Terminal Server (to support CMS terminals and 
printers)

The Solstice DiskSuite software package allows the disks of a Sun 
SPARCserver system to be managed as if they were a single file system. 
This software is included in all new CentreVu CMS R3V6 installations.

Required software for 
a Windows client 
platform 1

CentreVu Visual Vectors software runs under Windows 95/98 or 
Windows NT 4.0. When running under Windows NT 4.0, CentreVu Visual 
Vectors 1.0 client software requires Service Pack 3 or later to be 
installed.

Note: The required browser for CentreVu Visual Vectors on-line help 
system is Microsoft Internet Explorer  3.02 or later. Before installing 
CentreVu Visual Vectors, ensure that Microsoft Internet Explorer  3.02 or 
later is correctly installed; however, it does not need to be set as your 
default browser or .htm application.
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Supported Switches 1

Switch names and 
releases 1

CentreVu CMS/Visual Vectors Server software is certified to run with the 
following releases of Lucent Technologies switches: 

● DEFINITY Enterprise Communications Server Release 6.3

● DEFINITY ECS Release 7.

Single and multiple 
ACDs 1

Depending on which computer you have and how the CentreVu CMS 
software was installed, the CentreVu CMS software can communicate 
with as many as eight ACDs. 

Depending on how the Visual Vectors Server software was installed and 
configured, the CentreVu Visual Vectors 1.0 client software can 
communicate with as many as 20 CentreVu CMS/Visual Vectors servers.

References to multiple ACDs in this document refer to multiple-switch 
configurations. If you have only one switch, you can ignore multiple-ACD 
considerations. 



  
Introduction CentreVu® Visual Vectors Version 1.0 User Guide

General Information 1-6

Prerequisite Switch and CentreVu CMS Features 1

Purpose 1 CentreVu CMS includes a feature for administering automatic call 
distribution (ACD) and optional features for managing aspects of the 
system. The features required to use CentreVu Visual Vectors software 
are described below.

ACD Administration 
and Visual Vectors 1

CentreVu CMS/Visual Vectors software provides an administrative 
interface to the switch. The CentreVu CMS software supports CentreVu 
Supervisor clients. Using the Agent Administration and Call Center 
Administration areas, administrators can use CentreVu Supervisor to 
view or change various ACD-, Vectoring-, and Expert Agent Selection 
(EAS)-related parameters on the switch, and to run reports that describe 
your call center configuration. For example, you can add agents to or 
remove agents from splits or skills; move extensions between splits; 
change skill assignments; change trunk group-to-split, trunk group-to-
VDN, or VDN-to-vector assignments; start an agent trace and list the 
agents being traced.

The Visual Vectors Server software supports CentreVu Visual Vectors 
clients. Using the CentreVu Visual Vectors client software, administrators 
can change certain properties of call center entities, as well as create and 
edit vectors, assign VDNs to vectors and set VDN Skill Preferences.

The CentreVu CMS/Visual Vectors administrator should coordinate with 
the ECS/switch administrator to be sure that the needed ACD/CMS 
configuration is understood by both people. 

Vectoring and Visual 
Vectors 1

The CentreVu CMS Call Vectoring feature enables you to create, copy, 
and edit vectors on any ECS. Call vectors are user-defined, call-
processing programs. Call vectors direct calls to specified on-network or 
off-network destinations, to queues in ACD splits, or to treatments such 
as music, recorded announcements, forced disconnect, and forced busy. 
CentreVu Visual Vectors provides a visually rich, intuitive graphical 
interface for this feature for call centers with DEFINITY ECS R6.3 or 7 
and CentreVu CMS R3V6 servers.

On the ECS and CentreVu CMS, Call Vectoring is a separately 
purchased feature that is required to use Visual Vectors software. All 
CentreVu Visual Vectors windows are described in this document. A 
description of ECS/G3 Vectoring is in the “Call Vectoring and Related 
ECS/G3 Features” appendix of CentreVu CMS R3V6 Administration, 
585-215-850. A description of Vector Contents and the allowed values for 
all the vectoring commands are in the “Vector Contents” appendix.
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Things to Know Before Using Visual Vectors 1

Overview 1

1 This section describes what you should know before using the CentreVu 
Visual Vectors software.

Interactions With CentreVu Supervisor 1

Purpose 1 CentreVu Framework and Visual Vectors software is designed to work 
with CentreVu Supervisor Version 6.

Interactions With 
CentreVu Supervisor 
Version 6 1

If CentreVu Supervisor Version 6 or later is correctly installed on your 
client PC, then Visual Vectors software will display a toolbar icon and 
menu item in the CentreVu Framework window which you may use to 
start the CentreVu Supervisor Version 6 software. 

Other than the ability to run it, CentreVu Visual Vectors 1.0 and CentreVu 
Supervisor Version 6 do not interact directly. If information from the two 
software programs does not seem to match, first try to log off the 
CentreVu CMS server in each program, and then log back on.

Using CentreVu 
Supervisor Version 6 1

Use CentreVu Supervisor Version 6 software to do the following:

● Generate reports on the VDNs, vectors and skill preferences you 
have assigned using CentreVu Visual Vectors tools.

● Assign names to splits/skills, trunk groups, ACDs, and 
Vectors/VDNs in the CentreVu CMS R3V6 Dictionary, so that the 
objects in your Call Center World will have more meaningful names.

See CentreVu Supervisor Version 6 Installation and Getting Started, 585-
215-860 and CentreVu Call Management System Release 3 Version 6 
Administration and Operations, 585-215-850 for more information.
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Interactions With CentreVu CMS 1

Purpose 1 CentreVu Visual Vectors software is designed to work with CentreVu 
CMS R3V6 or later.

Interactions With 
CentreVu CMS R3V6 1

If information obtained from the two client software programs does not 
seem to match, log off the CentreVu CMS R3V6 server from each client 
software program, and then log back on.

Important! 
Edit vectors only in Visual Vectors. If you use any other way to edit 
vectors, such as a CMS terminal, comments will not be attached to vector 
steps.

Using CentreVu 
Supervisor Version 6 1

Use CentreVu Supervisor Version 6 software to do the following:

● Generate reports on the VDNs, vectors and skill preferences you 
have assigned using CentreVu Visual Vectors tools.

● Assign names to entities such as splits/skills, trunk groups, ACDs, 
and Vectors/VDNs in the CentreVu CMS R3V6 Dictionary. You can 
use the Navigator tool in CentreVu Visual Vectors to give more 
meaningful names to these objects in your Call Center World.

See CentreVu Supervisor Version 6 Installation and Getting Started, 585-
215-860 and CentreVu Call Management System Release 3 Version 6 
Administration and Operations, 585-215-850 for more information.
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Terminology 1

Overview 1

1 This section describes the terms you need to know before you begin 
using Visual Vectors software. These terms, as well as others, are also 
defined in the Glossary.

Terms You Need to Know 1

Terms 1 You need to know the following terms to understand how to use the 
software.

Access Permissions
Permissions assigned to a user so that the user can access different 
areas of a server or administer specific entities (for example, splits/skills, 
trunk groups, vectors, and VDNs) of an ACD. Access permissions are 
specified as read or write permission. Read permission means the user 
can access and view data. Write permission means the user can add, 
modify, or delete data and execute processes.

Automatic Call  Distribution (ACD) 
A switch feature using software that channels high-volume incoming and 
outgoing call traffic to agents grouped in splits or skills.

Also an agent state where the extension is engaged on an ACD call.

See Redirect On No Answer and Auto-Available Split.

Call Center World 
A collection of objects and entities that can be viewed and administered 
through CentreVu Framework. What you can access, edit or assign 
depends on your permissions.

CentreVu Call Management System  (CMS) 
A software product used by business customers that have Lucent 
Technologies telecommunications switches/ECS and receive a large 
volume of telephone calls that are processed through the Automatic Call  
Distribution (ACD) feature of the switch/ECS. The CMS collects call-
traffic data, formats management reports, and provides an administrative 
interface to the ACD feature in the switch/ECS.
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CentreVu Framework 
The Visual Vectors software window from which you access tools such as 
Navigator, Vector Editor, and VDN Assignment. You can also use 
Framework File menu items to Connect to or Disconnect from CentreVu 
CMS servers.

CentreVu Supervisor
The Call Management System client application for the Microsoft 
Windows operating environment.

Dictionary
An area of CMS that can be used to assign names to various call center 
entities such as login IDs, splits/skills, trunk groups, VDNs and vectors. 
These names make call center data easier to interpret.

Entity 
A generic term that refers to one of the following: Announcement, 
Split/Skill, Trunk Group, VDN, or Vector. Entities that CentreVu Visual 
Vectors can view or administer include Vectors and VDNs. Entity names 
are obtained from the CentreVu CMS Dictionary; renaming entities using 
Visual Vectors results in changes to the CMS Dictionary.

Expert Agent Selection (EAS)
Expert Agent Selection (EAS) is an optional switch feature that builds on 
the power of the Call Vectoring and ACD features of the switch to match 
the skills required to handle a particular call to an agent who has at least 
one of the skills that a caller requires. The ACD queuing and the Queue 
and Check vector commands are used to route a call to an agent with the 
appropriate skill to handle that call. With EAS, call distribution is based on 
skill.

CentreVu CMS collects data on skills in the same manner as it collects 
data on splits.

CentreVu CMS also reports VDN data by VDN skill preference, so that 
customers can assess the call center performance relative to calls 
requiring particular skills. CMS reports how many calls were handled, 
how long these calls waited for service, and the average talk time for calls 
queued to a particular skill preference in a particular VDN.

Navigator 
The window that displays after you select it from the Tools menu or 
toolbar in the CentreVu Framework window. It consists of two panes: a 
hierarchical “tree” view of your Call Center World on the left and a list of 
objects or entities on the right.

User Permissions
An area of the CentreVu CMS server that allows the administrator to 
define what each user can access.
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VDN Assignment Wizard 
The VDN Assignment Wizard, accessed from CentreVu Framework, 
guides you through the process of assigning a vector and skill 
preferences to a VDN or multiple VDNs. This tool includes access to the 
window that displays after you select properties from the context menu of 
a VDN object.

Vector Directory Number (VDN)
An extension number that enables calls to connect to a vector for 
processing. A VDN is not assigned an equipment location. It is assigned 
to a vector. A VDN can connect calls to a vector when the calls arrive 
over an assigned automatic-in trunk group or when calls arrive over a 
dial-repeating (DID) trunk group and the final digits match the VDN. The 
VDN by itself may be dialed to access the vector from any extension 
connected to the switch.

Vector Editor 
This software tool, accessed from CentreVu Framework, allows you to 
create and edit vectors visually, by dragging and dropping icons 
representing commands from a palette and arranging them into vector 
steps in a work area. You can attach comments, change layout, and save 
and print the vectors.

Vector Step
One processing step in a vector. A vector step consists of a command 
and one or more conditions or parameters. These conditions or 
parameters are found on a step’s Properties window in Visual Vectors 
client software.

Vector Step Condition
A condition accompanying a vector command that defines the 
circumstances in which the command will be applied to a call. These 
conditions are found on a step’s Properties window in Visual Vectors 
client software.

Visual Vectors Client 
Client software which provides a rich, graphical user interface for creating 
or modifying configured elements of ACDs connected to a CMS. This 
software can be loaded directly on the user’s personal computer or 
downloaded  from a network.

Visual Vectors Server 
Server software which enables administration (changing or modifying 
configured elements) for ACDs connected to a CMS. This software 
resides on the CMS server.
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Things to Know About Call Center Data 1

Overview 1

1 This section describes the CentreVu CMS processes for storing and 
tracking switch (ACD) data for your call center. The information is 
intended to give you an overview of how CentreVu CMS works, and 
where CentreVu CMS stores data. Visual Vectors Server software 
accesses CMS Dictionary and User Permissions data.

In this section 1 This section has one part:

● How CentreVu CMS Stores ACD Data

How CentreVu CMS Stores ACD Data 1

Real-time and 
historical databases 1

CentreVu CMS stores the ACD data received from the switch in the real-
time and historical databases. Within each of these databases, CentreVu 
CMS stores the specific ACD data for agents, splits/skills, trunks, trunk 
groups, vectors, and VDNs in separate database tables. Call work codes 
(CWC) also have separate database tables in the real-time and historical 
database.

Summarizing CMS 
Data 1

As CentreVu CMS collects the real-time data from the ACD, the data is 
stored in the current intrahour interval tables (agent, split/skill, trunk, 
trunk group, vector, and VDN) until the end of the interval. At the end of 
the current intrahour interval, data is archived to the previous intrahour 
interval tables and to the intrahour historical tables. At your designated 
data summarizing time, the historical intrahour data is summarized into 
daily data. At the end of your designated week (as specified on the 
System Setup subsystem Storage Intervals window), the daily data is 
summarized into weekly data. On the first day of a new month, monthly 
summaries are generated from the daily data for the previous month.
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CMS Dictionary 1 The CMS Dictionary contains names for call center ACDS and their 
entities, including announcements, splits/skills,  trunk groups, VDNs, and 
vectors. The assigned names appear on CMS reports to make them 
easier to interpret, as well as in Visual Vectors software to make it easier 
to use. You can use Visual Vectors tools to rename entities, or edit certain 
other properties of them (for example, their descriptions). See CentreVu 
Call Management System Release 3 Version 6 Administration and 
Operations, 585-215-850 for more information about CentreVu CMS 
Dictionary.

User Permissions 1 Visual Vectors software determines what users can view and modify 
based on CMS User Permissions. For example, if a user has read access 
for an ACD and/or its vectors but no write access, the user will not be 
able to use Vector Editor to save, or Navigator to copy, a vector to that 
ACD. Likewise, if a user has no read or write access permissions for a 
type of entity (for example, VDNs), then the folder for those entities on 
the ACD will appear empty in Navigator. See CentreVu Call Management 
System Release 3 Version 6 Administration and Operations, 585-215-
850 for more information about CentreVu CMS User Permissions.

Important! 
If more than 2,000 VDNs have been authorized on a CentreVu CMS 
R3V6 server, then VDN permission checking (enabled through User 
Permissions’ VDN Access operation) is not available.
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Prerequisite System Administration 1

Overview 1

1 This section describes system administration required before you can run 
CentreVu Visual Vectors software.

In this section 1 This section consists of the following:

● Configuring the server, server performance and delay estimates.

● Obtaining technical support for Visual Vectors software

● CentreVu Visual Vectors Training.
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Configuring Visual Vectors Server 1

Overview 1 Typically, an administrator will have installed and configured the 
CentreVu Visual Vectors Server. However, if you need to install and 
configure the server, first refer to Chapter 4 of CentreVu CMS R3V6 
Upgrades and Migration, Issue 2, 585-215-856 for instructions on how to 
proceed. A brief outline follows of the procedures to install the CentreVu 
Visual Vectors Server software package.

How to install Visual 
Vectors Server 
software 1

1. Log in as root.

Result
You are ready to begin installing the software package.

2. Insert the CD-ROM and enter the following command: 
/usr/sbin/pkgadd -d /cdrom/cdrom0.

Result
The system displays information about the CD contents.

3. Enter option 1 or press Return to select Visual Vectors Server 
software for processing.

Result
The system queries if you wish to continue.

4. Enter y to continue installation.

Result
The CD package information is re-displayed.

5. After verifying this information, enter q at the prompt.

Result
The installation process ends.

How to set up your 
server software iitially 1

1. At the system prompt, enter the following command: setupaas

2. Select option 1 from the displayed setup menu.

3. Enter the number of allowable concurrent logins. The maximum 
number is the number of purchased licenses.

How to start Visual 
Vectors Server 
software 1

1. At the system prompt, enter the following command: setupaas

2. Select option 2 from the displayed setup menu.

3. Select option 1 from the turn on/stop menu to start the software.
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Server performance 1 The following table summarizes capacity limits for CMS hardware 
platforms running CentreVu Visual Vectors Server software:

Delay estimates 1 The following table estimates the delay (in seconds) to navigate VDNs for 
some CMS hardware platforms running CentreVu Visual Vectors Server 
software:

Platform

Simulta-
neous 

realtime 
reports

Historical, 
forecast, 
ICH, and 

agent trace 
reports per 

hour

ODBC 
reports 

per hour

Web hits 
per hour

VDNs 
on any 
single 
ACD

Sparc 5 200 80 80 40,000 1300

Ultra 5 300 120 120 60,000 1950

UE3000 
(1 CPU)

400 160 160 80,000 2600

UE3000 
(2 CPUs)

800 320 320 160,000 5200

E3500 (2 
CPUs)

1200 480 480 240,000 7800

E3500 (4 
CPUs)

2400 960 960 480,000 15,600

Platform/VDNs 250 500 1000 2000 4000 8000

Sparc 5 9.0 14.1 24.4 45.0 86.2 168.6

Ultra 5 5.8 9.0 15.6 28.8 55.2 107.9

UE3000 (1 CPU) 4.5 7.1 12.2 22.5 43.1 84.3

UE3000 (2 
CPUs)

2.3 3.6 6.1 11.3 21.6 43.2

E3500 (2 CPUs) 1.5 2.4 4.1 7.6 14.6 28.6

E3500 (4 CPUs) 0.8 1.2 2.1 3.8 7.3 14.3
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CentreVu Visual Vectors Training 1

Training included with 
software 1

If you are a U.S. customer, your Lucent Technologies Project Manager 
should call 1-800-255-8988 to schedule the appropriate classes for you. 
For training outside the United States, contact your local Lucent 
distributor or representative. 

Available courses 1 The available training courses are shown in this table.

Course # PEC Course Name Description

 BTC124H  1460-
057

DEFINITY 
ECS with EAS

A 4-day course that provides 
training on the tasks required 
to set up a  G3 switch with 
the EAS feature and design 
vectors.

 BTC138H  DEFINITY 
ECS G3 ACD 
with Vectoring

A 4-day course that provides 
training on the tasks required 
to set up a CentreVu CMScall 
center application with the 
G2.2 switch and the EAS 
feature, administer CentreVu 
CMS, interpret reports on 
ACD activity, and use the 
Vectoring and Forecast 
features. 

 BTC429M  not 
listed

DEFINITY 
ACD and 
Vectoring

This CD-ROM course lasts 
approximately 1.5 hours. It 
provides hands-on 
experience administering the 
ACD feature with vectoring.
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 BTC155H 1462-
031

CentreVu 
Supervisor V6 
Administration 
with EAS

A 4.5 day class that provides 
training on the tasks required 
to administer CentreVu CMS 
using CentreVuSupervisor 6, 
interpret reports of ACD 
activity in the CentreVu 
Supervisor Interface and use 
the vectoring and forecasting 
features in the CMS 
interface. 

 BTC154H 1462-
030

CentreVu 
Supervisor V6 
Administration

 

A 4.5 day class that provides 
training on the tasks required 
to administer CentreVu CMS 
using CentreVuSupervisor 6, 
interpret reports of ACD 
activity in the CentreVu 
Supervisor Interface and use 
the vectoring and forecasting 
features in the CMS 
interface. 

BTC447M 1472-
006

CentreVu 
Supervisor V6 
Administration

 (with and 
without EAS)

This CD-ROM course lasts 
approximately four hours.  It 
covers the tasks required to 
administer CMS and how to 
use the CentreVu Supervisor 
tools. This course includes 
system simulations, hands-
on exercises and supporting 
material.

 BTC115H 1462-
014

CentreVu 
CMS Custom 
Reports

A 3 day class that provides 
training on the tasks required 
to develop CMS custom 
reports.

Course # PEC Course Name Description
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Course notes

Price Elements Codes (PECs) should be used only to enroll additional 
persons (those who are not the two persons to receive training at no 
additional charge).

The last lesson (the last half-day) in the Administration courses covers 
the Forecast feature. Also, the student can view the CentreVu Visual 
Vectors User Training CD-ROM. If you have not purchased the Forecast 
or Vectoring features, you do not have to attend this session.

Other  training 1 You may benefit by taking additional courses (available at additional 
charges) in the following subject areas: 

● Solaris system

● INFORMIX

● Traffic Theory/Data Analysis

● Host Computer Administration

● Switch Administration.

 BTC450M 1472-
005

CentreVu 
Advocate: 
Breakthrough 
Solutions

This CD-ROM course lasts 
approximately 4 hours. It 
teaches how to use CentreVu 
Advocate to better manage 
their Call Center Resources. 
This course includes system 
simulations, hands-on 
exercises and support 
material.

BTC467M not 
listed

CentreVu 
Visual Vectors 
User Training

This CD-ROM course lasts 
approximately 2 hours. It 
teaches how to uses Visual 
Vectors to create vectors and 
how to assign VDNs to 
vectors. The course includes 
system simulations, hands-
on exercises and supporting 
material.

Course # PEC Course Name Description
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You automatically receive the following Individualized Learning Programs 
(booklets) after one of your call center’s employees is enrolled in the 
CentreVu CMS Administration course:

● ACD Fundamentals

● Vectoring and EAS Basics.
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Setting Up Your Call Center 
World 2

Overview 2

2 This chapter explains how to set up the Call Center World seen in the 
Navigator.

It is divided into the following sections:

● Call Center World Overview

● Adding and Deleting Objects in the Call Center World

● Call Center World Objects

● Object Properties.

See the overview of each section for a preview of the section’s contents.
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Call Center World Overview 2

Overview 2

2 To use CentreVu Framework and Visual Vectors software, you need to 
set up a Call Center World. A number of ACD, CentreVu CMS and 
CentreVu Supervisor terms must be understood to set up your Call 
Center World.
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Terms You Need to Know 2

Terms 2 Before you begin using the software, you should know the meaning of 
several terms. These terms, as well as others, are also defined in the 
Glossary.

Accelerator Keys  
Keys that provide shortcuts to actions available on the menu.

CentreVu Visual Vectors window 
The window in which you are currently working (usually indicated by a 
highlighted title bar). Visual Vectors has a Framework window and 
windows for each of the tools, including Navigator, Vector Editor, and 
VDN Assignment.

Container 
An object in your Call Center World that logically contains other entities or 
objects. For example, each CMS object in your Call Center World can 
contain as many as 8 ACD objects, each of which contains entity folders 
(for announcements, split or skill objects, trunk groups, VDNs, and 
vectors).

Context menu 
A menu with specific actions for an entity or item.

Entity 
A generic term that refers to one of the following: Announcement, 
Split/Skill, Trunk Group, VDN, or Vector. Entities that CentreVu Visual 
Vectors can view or administer include Vectors and VDNs. Entity names 
are obtained from the CentreVu CMS Dictionary; renaming entities using 
Visual Vectors results in changes to the CMS Dictionary.

Folder 
An object in the Navigator tool that contains entities (announcements, 
splits/skills, trunk groups, VDNs, and vectors). Folders are used to 
visually group all entities of a specific type for an ACD.

Input field 
An area in a window into which you enter one or more valid values. Valid 
values may be integers, for example, or names assigned in the CentreVu 
CMS Dictionary.

Menu bar  
A menu bar is under the title bar of most windows. The menu bar shows 
the menu names available for that particular window (for example, File 
and Help). You select an item from one of these drop-down menus.
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Navigator 
A window that displays after you select it from the Tools menu or toolbar 
in the CentreVu Framework window. It consists of two panes: a 
hierarchical “tree” view of your Call Center World on the left and a list of 
objects or entities on the right.

Object 
Any item which may appear in your Call Center World through the 
Navigator tool. Objects can be containers of other objects or entities 
(VDNs folder), or an object may be an administerable entity itself (VDN).

Status bar 
A status bar is across the bottom of some windows. The status bar shows 
information about the current action in that window.

Title bar 
A title bar is across the top of most windows. The title bar shows the 
name of that particular window (for example, Navigator). Titles of open 
tool windows will be listed on the Window menu of CentreVu Framework.

Toolbar 
A toolbar is under the menu bar of most windows. Toolbar icons 
represent actions you can perform.

Tooltips 
Tooltips are available in most windows by placing the mouse cursor over 
an item for two seconds. Tooltips usually describe the actions performed 
by selecting an icon. Tooltips can be disabled on the Preferences window 
accessed from the Tools menu of CentreVu Framework.

VDN Assignment 
The window that displays after you select it from the Tools menu or 
toolbar in the CentreVu Framework window. It consists of several dialog 
boxes in sequence; for example, one filters and selects the VDNs you 
wish to assign, and another performs the assignment(s).

Vector Editor 
This software tool, accessed from CentreVu Framework, allows you to 
create and edit vectors visually, by dragging and dropping icons 
representing commands from a palette and arranging them into vector 
steps in a work area. You can attach comments, change layout, and save 
and print the vectors.
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Adding and Deleting Objects in the Call Center World 2

Overview 2

2 This section describes how you add or delete objects in your Call Center 
World.

In this section 2 Topics in this section include:

● Basic Framework window features

● Basic Navigator features

● Using Visual Vectors window features

● Adding objects

● Selecting objects and performing actions

● Deleting objects

● Renaming objects

● Changing other object properties

● Completing input fields

● Rules for field entry
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Basic Framework Window Features 2

Overview 2 This section describes the features of the CentreVu Framework window 
in the Visual Vectors software. 

System menu box 2 A common convention. The system menu box enables you to perform 
basic operations, such as closing the current window or software 
program. 

Title bar 2 A common convention. The title bar shows the name of the tool. When a 
vector is open in the Vector Editor, its name is shown.

Minimize, 
maximize/restore, and 
close buttons 2

A common convention. The buttons adjust the size of the current window, 
or close it. 

Toolbar 2 The toolbar contains buttons for quick access to specific features of the 
application. When you move your cursor over a toolbar button, a tooltip 
displays with a brief description of what the button does. After you select 
a button, the status bar displays a description of the command that the 
particular button is performing. 

These buttons appear on the toolbar.

Button Function

Connect Initiates a connection to a CMS server.

Disconnect Disabled until you are connected to a CMS server.

Navigator Accesses the window for the Navigator tool. 

Vector Editor Accesses the window for the Vector Editor tool. 

VDN 
Assignment

Accesses the first of a series of windows for the VDN 
Assignment Wizard tool. 
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Status bar 2 The status bar is located at the bottom of the CentreVu Framework and 
Vector Editor windows. Framework displays a brief description of what 
actions are occurring; Vector Editor displays the number of steps in the 
current vector. 

Menu bar 2 A common convention. The menu bar lists the available drop-down 
menus. This section identifies the menus that are available before you 
log into the CMS server: File, Tools, Window, and Help.

File Menu 2 From this menu, you can initiate or discontinue a connection to a CMS 
server. The menu has the following items.

Connect
Displays the Connect to server window.

You can select from the drop-down list of servers to which you’ve 

previously connected, or select the New CMS button to identify a new 
server to log into and add to your Call Center World.

CentreVu 
Supervisor

Launches CentreVu Supervisor Version 6, if that 
program is installed correctly. If not, this button does 
not appear.

Help Contents Launches the Help application window for Visual 
Vectors. 

Button Function
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Disconnect
Displays the Disconnect window listing servers to which you are 
connected.

Highlight the server(s) from which you wish to disconnect and select the 

Disconnect button or press the Enter key.

Exit
Automatically disconnects from any CMS servers to which you are 
connected and then closes CentreVu Framework window. A warning 
message appears if you have open tool windows.

Tools Menu 2 Select the Tools menu to access the following items.

Navigator
Opens the window for the Navigator. You can view, add, delete, or move 
objects in your Call Center World using this window.

Vector Editor
Opens the window for the Vector Editor. You can create new or edit 
existing vectors in this window, and then save them to an ACD (if you 
have the needed permissions) or the scratchpad on your PC.

VDN Assignment Wizard
Opens the first of a series of windows for the VDN Assignment Wizard. 
This tool enables you to assign VDNs to vectors and VDN skill 
preferences. You can also view which VDNs are assigned to which 
vectors and, if necessary, change those assignments.

CentreVu Supervisor (if installed correctly)
Launches a separate session of your CentreVu Supervisor application 
software. Other than this shortcut, the two programs are autonomous.
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Preferences...
Opens the Preferences window, from which you can view or modify 
settings such as Locale and whether Tooltips are enabled.

Advanced Debugging...
Used for debugging. Do not change the settings on the Advanced 
window unless you are instructed to do so by a Lucent Technologies 
assistant.

Window Menu 2 Select Window from the menu bar to choose from the following items.

Close All
Closes the windows of all open tools, but leaves the CentreVu 
Framework window open and Visual Vectors software running.

Window List
Makes the selected Visual Vectors tool the current window. 

Help Menu 2 Press the F1 key or select the Help button to display help on a window or 
tool. Select Help from the menu bar to choose from the following options.

Help Contents
Opens the Help window, and displays the Visual Vectors table of 
contents. 

About…
Displays the About CentreVu Visual Vectors… window, which shows the 
software build number. 
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Basic Navigator Window Features 2

Overview 2 Whether you are logged into a CMS server and your CentreVu 
CMS/Visual Vectors user permissions determines the objects shown in 
Navigator and the menu items and toolbar buttons available to you for 
those objects.

Navigator Toolbar 2 The toolbar contains buttons for quick access to specific features of the 
application. When you move your cursor over a toolbar button, a tooltip 
displays with a brief description of the command the button performs and 
a tooltip.

The default Navigator toolbar buttons are as follows: 

Button Function

Up One Level Makes the parent of the current object the new 
current object. 

New Creates a new object (scratchpad or vector) within 
the current object. 

Delete Deletes the currently selected object. 

Rename Enters the edit mode on the name property of the 
selected object. 

Properties Displays the Property window for the current 
object(s). 

Undo Undoes the last action performed in this window. 

Redo Performs the last action undone in this window. 

Cut Removes the selected object(s) to be pasted later.

Copy Copies the selected object(s) to be pasted later.

Paste Pastes the previously cut or copied object(s) into the 
current folder and over the current selection (if there 
is one).

Details Changes the view in the right-hand pane from a list 
of object icons to one row of data per object. 
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Status indicators 2

These indicators in the Navigator tell you about the state of a CMS server 
and its measured ACDs.

Menu bar 2 This section identifies the four menus that are available after you log into 
a CMS server: File, Edit, View, and Help.

File Menu 2 The File menu has the following items.

New
Creates a new object in your Call Center World.

Delete
Removes an object from your Call Center World.

Rename
Enters the editing mode for the name property of the selected object.

Properties
Accesses the Properties window for the selected object.

Close
Closes the current window.

List Changes the view in the right-hand pane from one 
row of data per object to a list of object icons. 

Help Contents Starts the Help system and displays the default 
page. This function may take several seconds.

Button Function

This indicator 
… Displays …

Login status The icon for the CMS object in Navigator displays a 
black screen if you are not connected.

ACD link status Icons for the ACDs that are supported by the CMS. If 
the link to an ACD is down, the icon is crossed out. If 
the CMS server is connected to the ACD via a 
TCP/IP connection and the connection is in a 
transient state, the icon changes to a straight line.
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Edit Menu 2 The Edit menu has the following items.

Undo
Undoes the last action performed in this Navigator session.

Redo
Redoes the last action that was undone in this Navigator session.

Cut
Removes the selected object to be pasted later.

Copy
Copies the selected object to be pasted later.

Paste
Pastes the object that was previously cut or copied.

View Menu 2 The View menu has the following items.

Up One Level
Highlights the “parent” object of the selected object in the left pane, 
displaying the parent object's contents in the right pane.

Details
Changes the information displayed in the right pane for objects selected 
in the left pane. Details view is the default, showing one row for each 
object contained in the object selected in the left pane. Each row contains 
columns for the Name, Type, and your read/write Permissions of the 
object.

List
Changes the information displayed in the right pane for objects selected 
in the left pane. List view shows one named icon for each object 
contained in the object that is selected in the left pane.

Refresh
Refreshes and redraws the highlighted pane in the current window.

Help Menu 2 Press the F1 key or select the Help button to display help on a window or 
tool. Select Help from the menu bar to choose from the following items.

Help Contents
Opens the Help window, and displays the Visual Vectors table of 
contents. 

About…
Displays the About CentreVu Visual Vectors… window, which shows the 
software build number. 
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Using Visual Vectors Windows 2

Overview 2 This section describes how to use features that are common to all Visual 
Vectors windows: the menus, toolbars, and Help system.

Visual Vectors menus 2 To select a menu item, choose any of the following methods: 

● Click on the item.

● Use the arrow keys to highlight the item and then press the Enter 
key.. 

● Hold down the Alt key and press the underlined letter in the menu 
item you want to select

● Press the key or combination of keys (usually the Alt key or the Ctrl 
key and a letter key) assigned to the operation. For example, use 
Ctrl+C to copy. 

Visual Vectors toolbars2 All items available on Visual Vectors toolbars are also available within the 
menus. To select a toolbar item, click on the icon.

Help system 2 Press the F1 key or select the Help button to display help for a window. 
Select Help from the menu bar to choose from the help options described 
in “Basic Framework Window Features” on page 2-6.
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Adding New CentreVu CMS Servers 2

Procedure 2 To establish a connection with a new CentreVu CMS server (one that is 
not already in your Call Center World), complete the following steps:

1. In the CentreVu Framework window, select Connect from the File 
menu or the toolbar, and then select New CMS  in the Connect to 
server window.

OR

In the Navigator window, highlight Call Center World in the left-hand 
pane, and then select New CMS from the File or context menu.

Result
The New CMS window opens. 

2. Type the hostname or IP address of a CentreVu CMS/Visual Vectors 
server in the Server Network Address box. 

3. Enter your CentreVu CMS login ID in the Login ID text box.

4. Type your CMS password in the Password text box.

5. Select OK.

Result

If the CMS server you entered:

● Exists and can be connected to — a new CMS object will be 
added to your Call Center World and you will be connected to 
this new server.

● Doesn't exist or cannot be connected to — an error message 
will be displayed showing the cause of the failure. Go to step 2.
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Adding objects 2

Purpose 2 You may want to add an object (for example, a new vector for an ACD in 
the Vector Folder) in your Call Center World. First, select a container for 
the object (for example, Vector Folder) in a Navigator window.

Adding an object 2 Do this procedure to add an object (a new vector or scratchpad) to your 
Call Center World. If you add or save a vector to the Vector Folder on a 
measured ACD it will be added to the CMS database.

1. In the Navigator window, highlight a scratchpad or Vector Folder in 
the left-hand pane, and then select EAS Vector , Non-EAS Vector, 
EAS, Non-Prompting Vector, Non-EAS, Non-Prompting Vector and 
from the File or context menu. If you highlighted a scratchpad, you 
can also select New scratchpad from the menu.

Result
The New Vector, New Vector (no EAS), or New ScratchPad window 
opens. 

2. Fill in the required information in the input field(s) on the window. For 
a new vector, a Name (and Id, if on an ACD) are required.

3. Select OK.

Result

If the addition

● was successful, the new object will appear in the Navigator.

● failed, an error message will be displayed showing the cause of 
the failure. 
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Selecting objects and performing actions 2

Overview 2 To perform any action on an object in your Call Center World, you must 
first select the object. To select an object, choose any of the following 
methods: 

● Click on the object

● Use the arrow keys to highlight the item and then press Enter 

● To select the object that contains the currently selected object, 
select Up One Level  from the View menu or Navigator toolbar. 

Input window actions 2 Use these input window features to do the following:

Feature Action

Menu bar Pull down a list of CMS actions, edit options, and 
online help.

Toolbar action 
buttons

Click a button to perform a CMS action.

Input fields Type in the information needed to complete a CMS 
action.

Selection list View a list of the content you may enter in the input 
field.
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Deleting objects 2

Purpose 2 You may want to delete a CMS from your Call Center World or a vector 
from the CentreVu CMS database. To delete an object, first select it in a 
Navigator window.

Getting information 2 Do this procedure if you need information from the CMS database before 
you delete the item.

1. Select Properties from the File or context menu, select the 
Properties  button on the toolbar, or press Alt+Enter.

2. Locate the information for the item you want to delete and note the 
relevant information. 

3. Close the Properties window. 

Result
The Navigator window displays.

Deleting an object 2 Do this procedure to delete an object (a CMS or vector) from your Call 
Center World. 

1. Select the object.

2. Select Delete from the File or context menu, select the Delete button 
on the toolbar, or press Delete.

Result

If the deletion

● was successful, the contents of the object will be deleted and 
replaced with an empty vector in the Dictionary.

● failed, an error message will be displayed showing the cause of 
the failure. 
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Renaming objects 2

Purpose 2 You may want to rename an object that already exists in your Call Center 
World. First, select the object to be renamed.

Getting information 2 Do this procedure if you need information from the CMS database before 
you rename the item.

1. Select Properties from the File or context menu, select the 
Properties  button on the toolbar, or press Alt+Enter.

Result
The Properties of an object window appears.

2. Locate and note the relevant information. For example, verify the Id 
of the Vector you want to rename.

3. Close the Properties window. 

Result
The Navigator window displays.
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Renaming an object 2 Do this procedure to rename an ACD object in the CMS database. 

1. Select the object.

2. Select Rename from the File or context menu, or select the Rename 
button on the toolbar.

Result
The Renaming object window displays with the Name property field 
highlighted.

3. Type in the new name or edit the existing name and then select OK.

Result

If the object was

● renamed, the new name appears in the Navigator.

● not renamed, an error message will be displayed showing the 
cause of the failure. 
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Changing other properties 2

Purpose 2 If you want to view or change the properties of one or more object(s), 
click on the Properties toolbar button or select the menu item in the 
Navigator. A Properties window will open, from which you can make your 
selection(s).

Single object 2 If the property window is for a single object or entity (one split/skill, vector, 
VDN, or trunk group), a property window appears.

For split/skill, VDN, vector, trunk group and ACD, the window contains 
properties for an object for which you have permissions in the CMS 
Dictionary.
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Multiple objects 2 If the property window is for multiple entities such as split/skills, vectors, 
VDNs, or trunk groups, a multiple-object property window appears. 

For split/skill, VDN, vector, trunk group and ACD, the window contains 
properties for the objects for which you have permissions in the CMS 
Dictionary.

Changing properties 2 1. Click on the Properties toolbar button or select the menu item in the 
Navigator.

Result
A Properties window will open, in which you can edit certain item(s).

2. Click in (or Tab to) the property fields you want to change and edit 
the value in the field(s).

Result
A red box will be drawn around property fields with invalid values.

3. When you have made all your changes and no red boxes appear, 
select OK.
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Rules for Field Entry 2

2 When you change certain properties using Visual Vectors software, the 
CentreVu CMS server database  is updated. CMS has three classes of 
input field: name (synonym), description, and number. This section 
describes the rules that apply to each class.

Name 2 A name (synonym) property field:

● Must begin with an alphabetic character. Characters are case 
sensitive. 

● Can be 1 to 20 characters. Letters, numbers, underscores ( _), 
blanks, commas ( ,), periods ( .), and plus signs ( +) are valid. 

Description 2 A description property field can be 1 to 50 characters. All keyboard 
characters are allowed except backslash ( \), grave accent ( ‘), tilde ( ~ 
), double quotes ( "), pipe symbol ( |), asterisk ( *), and question mark ( 
?).

Number 2 A numeric entry can be a single value valid for the numeric property field
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Call Center World Objects 2

Overview 2

2 Objects include items on which you can perform actions in your Call 
Center World. The objects may be vectors, for example, or trunk groups 
or ACDs.

No matter which tool you use to select an object, the way in which you 
perform an action is the same. 

In this section 2 Topics include:

● Overview

● Objects in your Call Center World.
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Objects in Your Call Center World 2

Overview 2 The following describes all objects possible in your Call Center World.

● “Call Center World object” on page 2-24

● “ScratchPad object” on page 2-25

● “CMS object” on page 2-25

● “ACD object” on page 2-26

● “Announcement Folder object” on page 2-26

● “Announcement object” on page 2-26

● “Split/Skill Folder object” on page 2-27

● “Split/Skill object” on page 2-27

● “Trunk Group Folder object” on page 2-27

● “Trunk Group object” on page 2-27

● “Vector Folder object” on page 2-28

● “Vector object” on page 2-28

● “VDN Folder object” on page 2-29

● “VDN object” on page 2-29.

Call Center World 
object 2

The following describes the Call Center World object:

Actions Description

Explore Expands the Call Center World to show one or more 
CMS Servers for which you have read or read/write 
permission.

Disconnect All Displays the Disconnect window with all connected 
CMS servers highlighted.

Navigator Launches Navigator window with the Call Center 
World as place to start browsing

New CMS Accesses the New CMS window to add a new server 
to your world.

Properties Displays properties of the Call Center World.
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ScratchPad object 2 The following describes the ScratchPad object:

CMS object 2 The following describes the CMS object:

Actions Description

Explore Expands the ScratchPad

Navigator Launches Navigator window with the ScratchPad as 
place to start browsing.

New 
ScratchPad

Creates a new ScratchPad.

New EAS 
Vector

Creates a new EAS Vector

New Non-EAS 
Vector

Creates a new Non-EAS-Vector.

New EAS, 
Non-Prompting 
Vector

Creates a new EAS, Non-Prompting Vector.

New Non-EAS, 
Non-Prompting 
Vector

Creates a new Non-EAS, Non-Prompting Vector.

Cut Cuts the selected ScratchPad to be pasted later.

Copy Copies an object to be pasted later.

Paste Pastes an object, if there is one cut or copied.

Delete Deletes the selected object. 

Rename Places user in edit mode for the ScratchPad name 
field in the Renaming ScratchPad window.

Properties Displays properties of the ScratchPad.

Actions Descriptions

Explore Expands the CMS object to show one or more ACDs 
for which you have read or read/write permission.

Connect Displays the Connect to server window for this CMS.

Disconnect Displays the Disconnect window with this CMS 
highlighted.
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ACD object 2 The following describes the ACD object:

Announcement Folder 
object 2

The following describes the Announcement Folder object:

Announcement object 2 The following describes the Announcement object:

Navigator Launches Navigator window with the CMS as the 
place to start browsing.

Delete Removes the CMS from your Call Center World.

Properties Displays properties of the CMS.

Actions Descriptions

Actions Descriptions

Explore Expands the ACD object to show folders of CMS-
measured entities.

Navigator Launches Navigator window with the ACD as the 
place to start browsing.

Rename Places you in edit mode for the ACD name field in 
the Renaming ACD window.

Properties Displays properties of the ACD.

Actions Descriptions

Explore Expands the Announcement Folder.

Navigator Launches Navigator window with the folder as place 
to start browsing

Properties Displays properties of the Announcement Folder.

Actions Descriptions

Navigator Launches Navigator window with the announcement 
as place to start browsing.

Rename Places user in edit mode for the announcement 
name field in the Renaming announcement window.

Properties Displays properties of the announcement.
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Split/Skill Folder 
object 2

The following describes the Split/Skill Folder object:

Split/Skill object 2 The following describes the Split/Skill object:

Trunk Group Folder 
object 2

The following describes the Trunk Group Folder object:

Trunk Group object 2 The following describes the Trunk Group object:

Actions Descriptions

Explore Expands the Split/Skill Folder.

Navigator Launches Navigator window with the folder as place 
to start browsing.

Properties Displays properties of the Split/Skill Folder.

Actions Descriptions

Navigator Launches Navigator window with the split or skill as 
place to start browsing.

Rename Places user in edit mode for the Split/Skill name field 
in the Renaming split/skill window.

Properties Displays properties of the Split/Skill.

Actions Descriptions

Explore Expands the Trunk Groups folder.

Navigator Launches Navigator window with the folder as place 
to start browsing.

Properties Displays properties of the Trunk Groups folder.

Actions Descriptions

Navigator Launches Navigator window with the trunk group as 
place to start browsing.

Rename Places user in edit mode for the Trunk Group name 
field in the Renaming trunk group window.

Properties Displays properties of the Trunk Group.
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Vector Folder object 2 The following describes the Vector Folder object:

Vector object 2 The following describes the Vector object:

Actions Descriptions

Explore Expands the Vector Folder.

Navigator Launches Navigator window with the folder as place 
to start browsing.

New Vector Creates a new vector with one Stop step in the 
folder.

Properties Displays properties of the Vector Folder.

Actions Descriptions

Edit Accesses the Vector Editor tool to edit the vector.

View as ASCII Displays the vector in a window as plain text (read-
only).

Navigator Launches Navigator window with the vector as place 
to start browsing.

Cut Copies a vector and replaces it with a blank vector, 
and leaves the name in the Dictionary.

Copy Copies a vector to be pasted later.

Paste Pastes an object, if there is one cut or copied.

Delete Deletes the vector from the folder for this ACD. This 
replcaes it with a blank vector, and leaves the name 
in the Dictionary.

Rename Places user in edit mode for the Vector name field in 
the Renaming vector Id window.

Properties Displays properties of the vector.
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VDN Folder object 2 The following describes the VDN Folder object:

VDN object 2 The following describes the VDN object:

Actions Descriptions

Explore Expands the VDNs folder.

Navigator Launches Navigator window with the folder as place 
to start browsing.

Properties Displays properties of the VDN Folder.

Actions Descriptions

Navigator Launches Navigator window with the VDN as place 
to start browsing.

Rename Places user in edit mode for the VDN name field in 
the Renaming VDN window.

Properties Displays properties of the VDN.



  
Setting Up Your Call Center World CentreVu® Visual Vectors Version 1.0 User Guide

Call Center World Object Properties 2-30

Call Center World Object Properties 2

Overview 2

2 Use object properties to change certain allowable parameters of:

● Any measured subsets (entities) of the ACD, including 
announcements, splits/skills, trunk groups, VDNs, and vectors

● VDN administration (for example, its assigned vector and skill 
preferences)

In this section 2 Topics include:

● Overview

● Properties of Call Center World Objects.
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Properties of Objects 2

Overview 2 The following describes the properties of all objects in your Call Center 
World. 

● “Call Center World object” on page 2-31

● “ScratchPad object” on page 2-32

● “CMS object” on page 2-32

● “ACD object” on page 2-33

● “Announcement Folder object” on page 2-33

● “Announcement object” on page 2-34

● “Split/Skill Folder object” on page 2-34

● “Split/Skill object” on page 2-35

● “Trunk Group Folder object” on page 2-35

● “Trunk Group object” on page 2-36

● “Vector Folder object” on page 2-36

● “Vector object” on page 2-37

● “VDN Folder object” on page 2-37

● “VDN object” on page 2-38.

Call Center World 
object 2

The following describes properties of the Call Center World object:

Properties Description

Name You cannot edit this name.

Type Type of object (World).

Permission Displays permission (R for read) you have for World.

Description Characters describing the Call Center World. You 
can edit this field.
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ScratchPad object 2 The following describes properties of the ScratchPad object:

CMS object 2 The following describes properties of the CMS object:

Properties Description

Name  Name of a folder containing off-line vectors.

Type Type of object.

Permission Displays scratchpad permissions (read and write).

Description Characters describing the scratchpad object. You 
can edit this field.

Properties Description

Name Name of the CentreVu CMS server. You cannot edit 
this name.

Type Type of CMS.

Permission Displays permissions (R for read, blank for none) 
you have for the CentreVu CMS server.

Version CentreVu CMS server software release and version 
numbers (R3V6).

Locale CentreVu CMS server software locale and time zone 
(for example, TZ GMT – 05:00).

Containee 
Count

The number of objects (ACDs) contained within this 
object.
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ACD object 2 The following describes properties of the ACD object:

Announcement Folder 
object 2

The following describes properties of the Announcement Folder object:

Properties Description

Name Name of the ACD in the CentreVu CMS Dictionary. 
You can rename it if you have ACD read and write 
access on the CMS.

Type Type of ACD

Permission Displays ACD permissions (read, write, or both) you 
have on the CentreVu CMS.

Id Number identifying the ACD on the CentreVu CMS.

Version DEFINITY server software release and version 
numbers (ECS R6).

Locale DEFINITY server software locale and time zone (for 
example, TZ GMT — 05:00).

Link Status Status (Link Up, Link Down) of the link to the ACD 
from CMS. The ACD icon is crossed out in Navigator 
if the link is down.

ACD Features Features enabled on the ACD (EAS, Prompting, 
Vectoring).

Description Characters describing the ACD in the CMS 
Dictionary. You can edit this field.

Properties Description

Name  Name of the folder containing measured 
announcements for this ACD.

Type Type of object.

Permission Displays announcement permissions (read, write, or 
both) you have for this ACD.

Containee 
Count

Shows the number of announcements contained in 
the folder.
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Announcement object 2 The following describes properties of the Announcement object:

Split/Skill Folder object2 The following describes properties of the Split/Skill Folder object:

Properties Description

Name  Name of the announcement in the CMS Dictionary. 
You can rename it if you have read/write 
permissions. 

Type Type of object.

Permission Displays permissions (read, write, or both) for this 
announcement.

Extension Announcement extension number.

Description Characters describing the announcement in the 
CMS Dictionary. You can edit this field.

Properties Description

Name  Name of the folder containing measured splits or 
skills for this ACD.

Type Type of object.

Permission Displays split/skill permissions (read, write, or both) 
you have for this ACD.

Containee 
Count

Shows the number of splits/skills contained in the 
folder.
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Split/Skill object 2 The following describes properties of the Split/Skill object:

Trunk Group Folder 
object 2

The following describes properties of the Trunk Group Folder object:

Properties Description

Name Name of the split/skill in the CentreVu CMS 
Dictionary.

Type Type of object.

Permission Displays permissions (read, write, or both) you have 
for this split/skill.

Id Number identifying the split/skill in the CMS 
Dictionary. You can edit this field.

Description Characters describing the split/skill in the CMS 
Dictionary. You can edit this field.

Properties Description

Name Name of the folder containing measured trunk 
groups for this ACD.

Type Type of object.

Permission Displays trunk group permissions (read, write, or 
both) you have for this ACD.

Containee 
Count

Shows the number of trunk groups contained in the 
folder.
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Trunk Group object 2 The following describes properties of the Trunk Group object:

Vector Folder object 2 The following describes properties of the Vector Folder object:

Properties Description

Name Name of the trunk group in the CentreVu CMS 
Dictionary.

Type Type of object.

Permission Displays permissions (read, write, or both) you have 
for this trunk group.

Id Number identifying the trunk group on the CentreVu 
CMS.

Description Characters describing the trunk group in the CMS 
Dictionary. You can edit this field.

Properties Description

Name Name of the folder containing measured vectors for 
this ACD.

Type Type of object.

Permission Displays vector permissions (read, write, or both) 
you have for this ACD.

Containee 
Count

Shows the number of vectors contained in the folder.
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Vector object 2 The following describes properties of the Vector object:

VDN Folder object 2 The following describes properties of the VDN Folder object:

Properties Description

Name Name of the vector in the CentreVu CMS Dictionary.

Type Type of object.

Permission Displays permissions (read, write, or both) you have 
for this vector

Description Characters describing the vector in the CMS 
Dictionary. You can edit this field.

Id Number identifying the vector on the CentreVu CMS.

Step Count Shows the number of steps contained in the vector.

Properties Description

Name Name of the folder containing measured VDNs for 
this ACD.

Type Type of object.

Permission Displays VDN permissions (read, write, or both) you 
have for this ACD.

Containee 
Count

Shows the number of VDNs contained in the folder.
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VDN object 2 The following describes properties of the VDN object:

Properties Description

Name Name of the VDN in the CentreVu CMS Dictionary.

Type Type of object.

Permission Displays permissions (read, write, or both) you have 
for this VDN.

Extension VDN extension number.

Vector Id Shows the number or synonym identifying the vector 
assigned to this VDN. You can change this 
assignment if you have VDN permissions on the 
CMS for the ACD.

Description Characters describing the VDN in the CMS 
Dictionary. You can edit this field.

Skill Pref Shows what skill preference(s) is(are) assigned to 
this VDN. You can change this assignment if you 
have VDN permissions on the CMS for the ACD 
(EAS only).
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Using Framework and Navigator 3

Overview 3

3 This chapter explains how to use CentreVu Framework and the Navigator 
tool.

It is divided into the following sections:

● Framework Software Overview

● How to Access Framework

● Selecting and Running Navigator

● Navigating Your Call Center World.

See the overview of each section for a preview of the section’s contents.
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Framework Software Overview 3

Overview 3

3 To run CentreVu Framework, you need to start the software and connect 
to at least one CentreVu CMSserver. You may choose additional 
CentreVu CMS servers to connect to, as well.

In this section 3 Information you should know before starting the software include:

● What you can do with the software

● Closing windows

● Disconnecting and exiting the software.

Framework’s Features 3

What you do with the 
software 3

CentreVu Framework has three main functions:

● To allow access to a set of tools, including the Navigator, Vector 
Editor, and VDN Assignment Wizard.

● To manage one or more connections to CentreVu CMS servers 
required to perform ACD actions such as renaming entities, saving 
vectors, and making VDN assignments.

● To help manage multiple tool windows.
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Closing windows 3

Procedures 3 To close a window, select Close from the File menu, or press Alt+ F4.

To close all windows, select the Close All item on the Window menu from 
the CentreVu Framework window.

Disconnecting and exiting the software 3

Procedure 3 To exit the software, select Exit from the File menu.

You may exit the software while connected to one or more CentreVu 
CMS server(s); Visual Vectors software disconnects you automatically 
before closing the CentreVu Framework window.

If you have open windows other than the CentreVu Framework window 
(such as the Vector Editor or Navigator tools), and you try to exit, a 
message displays. Select Yes to disconnect and exit.
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How to Access Framework 3

Overview 3

3 From the CentreVu Framework window you can access tools to view, 
modify, add, and delete ACD items in the CentreVu CMS database. You 
can use the Navigator to view or modify the properties of objects in your 
Call Center World, including renaming some types of objects. You can 
use the Vector Editor to create new vectors or edit existing ones, and you 
can use VDN Assignment Wizard to assign one or more VDN(s) to a 
vector.

No matter which tool you use to select an operation, the way in which you 
perform the operation is the same. 

In this section 3 Topics include:

● Starting CentreVu Framework 

● Accessing objects in your Call Center World

● Connecting to a CentreVu CMS Server.
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Starting CentreVu Framework 3

Procedure 3 Use the following steps to start Framework software on Windows 95/98 
or Windows NT 4.0.

1. Select Start from the taskbar.

2. Select Programs from the Start menu.

3. Select the “Lucent CentreVu Visual Vectors 1.0” program group.

4. Select “CentreVu Visual Vectors 1.0”.

Result

The software program starts and the Framework window opens. 
Although Visual Vectors is running, you are not yet connected to a CMS 
server.

CentreVu Framework is Visual Vectors main window. You will use the 
toolbar buttons and pull-down menus to access measured ACD 
information from a CMS server.

The following figure illustrates how Framework appears before logging 
into a CMS server.
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Accessing objects in your Call Center World 3

Procedure 3 To access objects in your Call Center World, complete the following 
steps:

1. Select Navigator from the Tools menu or Framework toolbar.

Result
The Navigator window opens. 

2. From the File menu in Navigator, or on the Navigator toolbar, select 
New to add an object, Copy to copy an object to paste later, Delete  
to remove an object, Rename to change an object’s name, or 
Properties to see an object’s properties.

Result

If you selected:

● New CMS — the New CMS Server window opens for you to 
specify the parameters of a new server.

● New ScratchPad — the New ScratchPad window opens for you 
to specify the name of a new off-line folder.

● New Vector — the New Vector window opens for you to specify 
the name. This feature can create a new online vector that 
contains one Stop step or an empty offline vector.

● Copy — the selected object is copied. You may paste it into an 
allowable container.
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● Delete — the selected object is removed.

● Rename — the Renaming object window appears with the 
object's name highlighted for editing.

● Properties — the Properties window for the selected object 
opens. Some fields may be editable; others are for display only.

3. Complete entries on the New, Rename, or Properties window (as 
applicable) and select OK.
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Connecting to a CentreVu CMS Server 3

Purpose 3 You can use the Connect menu item or toolbar button to log into a CMS 
server. 

Connection types 3 From CentreVu Framework, you can connect to one or more CMS 
server(s) in either of the following ways. Note that you are limited to one 
instance of a login ID per server.

Existing CMS 
A valid CMS login ID and password is entered in the Connect to server 
window. Once you select a server and OK, the CMS connection is 
established automatically. If the connection is broken or dropped while 
you are working with tools, you will be prompted to save online open 
vectors elsewhere.

New CMS 
To add a New CMS server to your Call Center World:

1. Access the New CMS window in one of the following ways: 

● In the CentreVu Framework window, select Connect from the 
File menu or the toolbar, and then select New CMS  in the 
Connect to server window.

● In the Navigator window, highlight Call Center World in the left-
hand pane, and then select New CMS from the File or context 
menu.

2. Type the hostname or IP address of a CentreVu CMS/Visual Vectors 
server in the Server Network Address box. Type a valid Login ID  
and Password for the server in this window.

3. Select OK.
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Connecting to a server 
in your Call Center 
World 3

To establish a CMS connection if the server exists in your Call Center 
World, complete the following steps:

1. Select Connect from the File menu, or click the Connect button on 
the toolbar.

Result

The Connect to server window opens.

2. Enter your CentreVu CMS login ID in the Login ID text box.

3. Tab to or click in the Password text box.

4. Type your CMS password in the Password text box.

5. Select a CMS server in you Call Center World from the drop-down 
list.

6. Select the Connect button.

Result
A status message indicates that the software is connecting to the 
CMS server.



  
Using Framework and Navigator CentreVu® Visual Vectors Version 1.0 User Guide

How to Access Framework 3-10

Connecting to a new 
CMS server 3

To establish a CMS connection if the server is not in your Call Center 
World, complete the following steps:

1. Select New CMS from the File  menu in the CentreVu Framework 
window.

Result
The New CMS window opens. 

2. Type the hostname or IP address of a CentreVu CMS/Visual Vectors 
server in the Server Network Address box. 

3. Enter your CentreVu CMS login ID in the Login ID text box.

4. Type your CMS password in the Password text box.

5. Select OK.

Result

If the CMS server you entered:

● Exists and can be connected to — a new CMS object will be 
added to your Call Center World and you will be connected to 
this new server.

● Doesn't exist or cannot be connected to — an error message 
will be displayed showing the cause of the failure. Go to step 2.
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Selecting and Running Navigator 3

Overview 3

3 This section introduces you to Navigator window features as they appear 
both before and after connecting to a CentreVu CMS server. Follow the 
instructions to — among other tasks — make menu selections, activate 
toolbar options, read status indicators, use windows, and enter values in 
input fields.

In this section 3 Topics in this section include:

● Basic Navigator window features

● Using Navigator window features.
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Basic Navigator Window Features 3

Overview 3 This section describes the features of the Navigator window. 

System menu box 3 A common Windows convention. The system menu box enables you to 
perform Windows operations, such as closing the current window or 
application. 

Title bar 3 A common Windows convention. The title bar shows the name of the 
application. 

Maximize, minimize 
and close buttons 3

A common Windows convention. The buttons adjust the size of the 
current window or close it. 

Toolbar 3 The toolbar contains buttons for quick access to specific features of the 
application. When you move your cursor over a toolbar button, a tooltip 
displays with a brief description of the command the button performs.
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The default toolbar buttons are as follows: 

Button Function

Up One Level Highlights the “parent” object of the selected object 
in the left pane, displaying the parent object's 
contents in the right pane.

New Creates a new object on the CMS server (or your PC 
ScratchPad).

Delete Removes an object from the CMS server (or your PC 
ScratchPad).

Rename Shows Renaming object window and enters the 
editing mode for the name of the selected object.

Properties Accesses the Properties window for the selected 
object.

Undo Undoes the last action performed in this Navigator 
session, up to four previous actions.

Redo Redoes the last action that was undone in this 
Navigator session, up to four previous actions.

Cut Removes the selected object and saves it to be 
pasted later.

Copy Makes a copy of the selected object to be pasted 
later.

Paste Pastes the object that was previously cut or copied.

Details Changes the information displayed in the right pane 
for objects selected in the left pane. Details view is 
the default, showing one row for each object 
contained in the object selected in the left pane. 
Each row contains columns for the object's Name, its 
Type, and your read/write Permissions for it.

List Changes the information displayed in the right pane 
for objects selected in the left pane. List view shows 
one named icon for each object contained in the 
object that is selected in the left pane.

Help Contents Opens the Help Topics window, and displays the 
table of contents. 
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Status indicators 3 These indicators on the status bar tell you about the state of CMS.

Status messages 3 The status bar of the CentreVu Framework window may display any of 
the following messages.

Menu bar 3 This section identifies the four menus that are available after you log into 
a CMS server: File, Edit, View, and Help.

File menu 3 The File menu has the following items. 

This indicator … Displays the …

Login status Icon for the CMS object in Navigator displays a 
black screen if you are not connected.

ACD link status Icons for the ACDs supported by a CMS server. If 
the link to an ACD is down, the icon is crossed out.

This message … Displays when …

Starting tool... A Visual Vectors window is opening. Framework 
is locked during this time. 

Looking for items 
to Connect...

Framework is searching your Call Center World 
for CMS servers. 
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New
Creates a new object on the CMS server (or your PC ScratchPad)..

Delete
Removes an object from the CMS server (or your PC ScratchPad).

Rename
Shows Renaming object window and enters the editing mode for the 
name of the selected object.

Properties
Accesses the Properties window for the selected object.

Close
Closes the Navigator tool’s window.

Edit menu 3 The Edit menu has the following items. 

Undo
Undoes the last action performed in this Navigator session, up to four 
previous actions.

Redo
Redoes the last action that was undone in this Navigator session, up to 
four previous actions.

Cut
Removes the selected object and saves it to be pasted later.

Copy
Makes a copy of the selected object to be pasted later.
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Paste
Pastes an object that was previously cut or copied.

View menu 3 The View menu has the following items. 

Up One Level
Highlights the “parent” object of the selected object in the left pane, 
displaying the parent object's contents in the right pane.

Details
Changes the information displayed in the right pane for objects selected 
in the left pane. Details view is the default, showing one row for each 
object contained in the object selected in the left pane. Each row contains 
columns for the object's Name, its Type, and your read/write Permissions 
for it.

List
Changes the information displayed in the right pane for objects selected 
in the left pane. List view shows one named icon for each object 
contained in the object that is selected in the left pane.

Refresh
Refreshes and redraws the both panes of the Navigator windows.
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Help menu 3 Press the F1 key or select the Help button to display context-sensitive 
help. Select Help from the menu bar to choose from the following items. 

Help Contents
Opens the Help Topics window, and displays the table of contents. 

About…
Opens the About… window, which shows the software version number. 
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Using Navigator Window Features 3

Overview 3 This section describes how to use three features that are common to all 
Navigator windows: the system tray icon, Navigator menus, and Help 
system.

Navigator menus 3 To select a Navigator menu item, choose any of the following methods: 

● Click on the item

● Use the arrow keys to highlight the item and then press Enter 

● Press the Alt key and press the underlined letter in the menu or item 
you want to select

● Hold down the Ctrl key and press the accelerator key assigned to 
the action. For example, use Ctrl+C to copy. 

Help system 3 Press the F1 key or select the Help button to display context-sensitive 
help. Select Help from the menu bar to choose from the Navigator help 
options described in “Basic Framework Window Features” on page 2-6.
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Navigating Your Call Center World 3

Overview 3

3 Use Navigator to browse the following ACD entities measured by 
CentreVu CMS:

● Any measured subset of the ACD, including announcements, 
splits/skills, trunk groups, VDNs, and vectors

● VDN administration, including the vector and skill preference(s) 
assigned to one or more VDN(s)

In this section 3 Topics in this section include:

● Exploring an object

● Using property windows

● Completing input fields.
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Exploring an Object 3

Actions and Properties3 The objects visible in Navigator windows have sets of:

● Actions that may be performed on them (see “Objects in Your Call 
Center World” on page 2-24)

● Properties, some of which may be modified (see “Using Property 
Windows” on page 3-21).

Procedure 3 1. Browse your Call Center World and find the object you want.

● Click the + icon next to an object (for example, a CMS) to 
expand the display and show objects contained by that object 
(for example, ACDs).

● If needed to reduce clutter, click the – icon to the left of an 
object to collapse the display and hide the objects within that 
object.

2. A double-click  (or highlight and then single-click) on an object 
performs the default function. For example, a double-click on a 
container allows you to explore it. However, a double-click on a 
vector takes you directly to editing the selected vector.

Alternatively, you can right-click on the object and select an item 
from its context menu.

3. Highlight and right-click to rename the object, edit its Properties, or 
perform other allowable actions.

For more information 3 To see what actions can be performed on each possible object in your 
Call Center World, refer to “Call Center World Objects” on page 2-23 in 
“Setting Up Your Call Center World” on page 2-1.
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Using Property Windows 3

Procedure 3

If you need to 
know... Then refer to...

What 
properties an 
object has

“Call Center World Object Properties” on page 2-30

How to edit 
properties

“Completing Input Fields” on page 3-22
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Completing Input Fields 3

Options 3 You can complete an input field on a window using several different 
methods.

● Typing the requested information in a box.

● Selecting the information from a drop-down list of valid entries. For 
example, the properties window for a VDN contains a drop-down list 
of vectors to which the VDN(s) may be assigned.

● Checking a box (or selecting one of a set of mutually exclusive 
options) for the input field. 
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Using the Vector Editor 4

Overview 4

4 This chapter explains how to use the Vector Editor.

It is divided into the following sections:

● Visual Vectors Overview

● Using the Vector Editor

● Printing Vectors.

See the overview of each section for a preview of the section’s contents.
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Vector Editor Overview 4

Overview 4

4 To run the Vector Editor tool, you need to start CentreVu Framework, 
open a vector form the Navigator tool, and then select the Vector Editor 
from the Tools menu or toolbar.

In this section 4 Starting to use visual vectors introduces a number of ACD and CentreVu 
CMS terms, including:

● Terms you need to know

● Visual Vectors’ features

● Starting the Vector Editor

● Accessing vectors in your Call Center World

● Closing windows

● Disconnecting and exiting the software.
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Terms You Need to Know 4

Terms 4 Before you begin using the software, you should know the meaning of 
several terms. These terms, as well as others, are also defined in the 
Glossary.

Accelerator Keys  
Keys that provide shortcuts to actions available on the menu.

Automatic Call  Distribution (ACD) 
A switch feature using software that channels high-volume incoming and  
outgoing call traffic to agent groups (splits or skills).

Also an agent state where the extension is engaged on an ACD call.

See Redirect On No Answer and Auto-Available Split.

Call Vectoring
A switch feature that provides a highly flexible method for processing 
ACD calls using VDNs and vectors as processing points between trunk 
groups and splits. Call vectoring permits treatment of calls that is 
independent of splits.

Similar to a computer program, a call vector is a set of instructions that 
control the routing of incoming calls based on conditions that occur in a 
call center environment. Examples of call vector conditions include time 
of day and the number of calls in queue.

CentreVu Visual Vectors window 
The window in which you are currently working (usually indicated by a 
highlighted title bar). Visual Vectors has a Framework window and 
windows for each of the tools, including Navigator, Vector Editor, and 
VDN Assignment.

Container 
An object in your Call Center World that logically contains other entities or 
objects. For example, each CMS object in your Call Center World can 
contain as many as 8 ACD objects, each of which contains entity folders 
(for announcements, split or skill objects, trunk groups, VDNs, and 
vectors).

Context menu 
A menu with specific actions for an entity or item.

Expert Agent Selection (EAS)
Expert Agent Selection (EAS) is an optional switch feature that builds on 
the power of the Call Vectoring and ACD features of the switch to match 
the skills required to handle a particular call to an agent who has at least 
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one of the skills that a caller requires. The ACD queuing and the Queue 
and Check vector commands are used to route a call to an agent with the 
appropriate skill to handle that call. With EAS, call distribution is based on 
skill.

CentreVu CMS collects data on skills in the same manner as it collects 
data on splits.

CentreVu CMS also reports VDN data by VDN skill preference, so that 
customers can assess the call center performance relative to calls 
requiring particular skills. CMS reports how many calls were handled, 
how long these calls waited for service, and the average talk time for calls 
queued to a particular skill preference in a particular VDN.

Folder 
An object in the Navigator tool that contains entities (announcements, 
splits/skills, trunk groups, VDNs, and vectors). Folders are used to 
visually group all entities of a specific type for an ACD.

Input field 
An area in a window into which you enter one or more valid values. Valid 
values may be integers, for example, or names assigned in the CentreVu 
CMS Dictionary.

Menu bar  
A menu bar is under the title bar of most windows. The menu bar shows 
the menu names available for that particular window (for example, File 
and Help). You select an item from one of these drop-down menus.

Name (synonym) fields  
Fields in which you may enter a name (synonym) that has been assigned 
in the CMS Dictionary (for example, the name of a vector).

Object 
Any item which may appear in your Call Center World through the 
Navigator tool. Objects can be containers of other objects or entities 
(VDNs folder), or an object may be an administerable entity itself (VDN).

Skill
Attributes of ACD agents with the EAS feature enabled. In relationship to 
your call center, think of skill as a specific customer need/requirement or 
perhaps a business need of your call center. You will be defining your 
skills based on the needs of your customers and your call center.

ScratchPad
The Default ScratchPad name is a container area on your PC designed 
to save vectors off-line. ScratchPad is available any time. You can create 
a hierarchy of sub-folders under the default folder by selecting New 
ScratchPad from Navigator’s File menu.
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Status bar 
A status bar is across the bottom of some windows. The status bar shows 
information about the current action in that window.

Switch
A private switching system providing voice-only or voice and data 
communications services (including access to public and private 
networks) for a group of terminals within a customer’s premises.

Title bar 
A title bar is across the top of most windows. The title bar shows the 
name of that particular window (for example, Navigator). Titles of open 
tool windows will be listed on the Window menu of CentreVu Framework.

Toolbar 
A toolbar is under the menu bar of most windows. Toolbar icons 
represent actions you can perform.

Tools menu 
A drop-down menu on the CentreVu Framework menu bar that gives you 
access to the Navigator, Vector Editor, and VDN Assignment tools.

Tooltips 
Tooltips are available in most windows by placing the mouse cursor over 
an item for two seconds. Tooltips usually describe the actions performed 
by selecting an icon. Tooltips can be disabled on the Preferences window 
accessed from the File menu of CentreVu Framework.

VDN
See Vector Directory Number.

VDN Assignment 
The window that displays after you select it from the Tools menu or 
toolbar in the CentreVu Framework window. It consists of several dialog 
boxes in sequence; for example, one filters and selects the VDNs you 
wish to assign, and another performs the assignment(s).

VDN Calls-Counted
Also known as counted-calls to VDN and active VDN calls. A Call 
Vectoring capability available with G3V4 or later switches. Counted-calls 
to VDN is a parameter of the go to step and go to vector 
commands that provides conditional branching (to a different step in the 
same vector or to a different vector) based on the number of incoming 
trunk calls a VDN is currently processing.

VDN Skill Preference
Up to three skill(s) can be assigned to a VDN. Calls use VDN skills for 
routing based on your preference (as you administer it in the vector). 
VDN skill preferences are referred to in the vector as “1st,” “2nd,” or “3rd.”
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Vector
A list of steps that process calls in a user-defined manner. The steps in a 
vector can send calls to splits, play announcements and music, 
disconnect calls, give calls a busy signal, or route calls to other 
destinations. Calls enter vector processing via VDNs, which may have 
received calls from assigned trunk groups, from other vectors, or from 
extensions connected to the switch.

Vector Command  
A vector step that describes the action to be executed for a call (for  
example, Queue, check, disconnect).

Vector Directory Number (VDN)
An extension number that enables calls to connect to a vector for 
processing. A VDN is not assigned an equipment location. It is assigned 
to a vector. A VDN can connect calls to a vector when the calls arrive 
over an assigned automatic-in trunk group or when calls arrive over a 
dial-repeating (DID) trunk group and the final digits match the VDN. The 
VDN by itself may be dialed to access the vector from any extension 
connected to the switch.

Vector Editor 
This software tool, accessed from CentreVu Framework, allows you to 
create and edit vectors visually, by dragging and dropping icons 
representing commands from a palette and arranging them into vector 
steps in a work area. You can attach comments, change layout, and save 
and print the vectors.

Vector Step
One processing step in a vector. A vector step consists of a command 
and one or more conditions or parameters. These conditions or 
parameters are found on a step’s Properties window in Visual Vectors 
client software.

Vector Step Condition
A condition accompanying a vector command that defines the 
circumstances in which the command will be applied to a call. These 
conditions are found on a step’s Properties window in Visual Vectors 
client software.
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Visual Vector’s Features 4

What you do with the 
software 4

Visual Vectors’ Vector Editor has three main functions:

● To allow visual creation and editing of vectors by an easy, drag-and-
drop method

● To provide an off-line PC area (a “scratchpad”) for saving vectors 
when a switch connection is not available or at any other time.

● To annotate (by attaching comments) and to print representations of 
vectors.

Note that the Navigator tool supplies a read-only plain text view of 
vectors for users familiar with accessing vectors via a terminal.



  
Using the Vector Editor CentreVu® Visual Vectors Version 1.0 User Guide

Vector Editor Overview 4-8

Starting the Vector Editor 4

Procedure 4 Use the steps below to start Vector Editor for Windows 95/98 or Windows 
NT 4.0.

1. Select Start from the taskbar.

2. Select Programs from the Start menu.

3. Select the Lucent CentreVu Visual Vectors 1.0 program group.

4. Select CentreVu Visual Vectors 1.0 from the menu.

5. Select Vector Editor from the Tools menu or toolbar in the CentreVu 
Framework window and the type of vector you want. You can also 
double-click on a vector in Navigator.

Results

The CentreVu Framework and Vector Editor tool windows are displayed. 
Although Framework is now running, you are not connected to a 
CentreVu CMS server.

The following figure illustrates how the main window appears before 
connecting to a CMS server.
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Accessing vectors in your Call Center World 4

Procedure 4 To access vectors in your Call Center World, complete the following 
steps:

1. Select Navigator from the Tools menu or CentreVu Framework 
toolbar.

Result
The Navigator window opens. 
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2. Select an object that can contain a vector, such as the scratchpad or 
an ACD’s Vector Folder in the Navigator window.

Result
The objects contained in the folder appear in the right-hand pane of 
the Navigator window.

3. From the File menu in Navigator, or on the Navigator toolbar, select 
EAS Vector, Non-EAS Vector, EAS, Non-Prompting Vector, or Non-
EAS, Non-Prompting Vector to add a vector with one Stop step,  
Delete  to remove a vector, Rename to edit the vector’s name, or 
Properties to see a vector’s properties.

Result

If you selected:

● EAS Vector, Non-EAS Vector, EAS, Non-Prompting Vector, or 
Non-EAS, Non-Prompting Vector — the New Vector window 
opens for you to specify the Name and Id properties of a new 
vector.

● Rename — the Renaming Vector window opens for you to edit 
the vector's name.

● Delete — the selected object is replaced with a blank object. 
This function leaves the object's name in the dictionary.

● Properties — the Properties window for the selected object 
opens.

4. Select OK.
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Closing windows 4

Procedures 4 To close an open tool such as the Vector Editor window, select Close 
from the File menu, or press Alt+ F4. If you have unsaved changes to the 
current vector, you will be prompted to save them.

To close all windows, select the Close All item on the Window menu from 
the CentreVu Framework window.

Important! 
If you try to close or exit the CentreVu Framework window and you have 
open tool windows, a warning message will be displayed. If you restart 
framework, it will attempt to restore the open windows and server 
connections. See “Disconnecting and exiting the software” on page 4-12
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Disconnecting and exiting the software 4

Procedure 4 To exit the software, select Exit from the File menu in the CentreVu 
Framework window.

The software automatically disconnects from any CMS servers to which 
you are connected and then closes CentreVu Framework window.

A warning message appears if you have open tool windows.  If you 
restart framework after closing it while leaving tools windows open, it will 
attempt to restore the open windows and server connections. 
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Using the Vector Editor 4

Overview 4

4 This section introduces you to the Vector Editor window features as they 
appear both before and after logging into CentreVu CMS. Follow the 
instructions to — among other tasks — create new vectors and edit 
existing ones and then save them in your Call Center World, use 
Properties windows, and enter values in input fields.

In this section 4 Topics in this section include:

● Basic Vector Editor window features

● Vector Editor features after connecting to a CMS Server

● Using Vector Editor window features

● Opening Vectors

● Using property windows

● Completing input fields

● Printing vectors.
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Basic Vector Editor Window Features 4

Overview 4 This section describes the features of the Vector Editor window. 

System menu box 4 A common convention. The system menu box enables you to perform 
Windows operations, such as closing the current window or application. 

Title bar 4 A common convention. The title bar shows the name of the application. 

Minimize, maximize 
and close buttons 4

A common convention. The buttons in the upper right-hand corner adjust 
the size of the current window, or close it. 

Toolbar 4 The toolbar contains buttons for quick access to specific features of the 
application. When you move your cursor over a toolbar button, a tooltip 
displays with a brief description of the command the button performs.
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The default Vector Editor toolbar buttons are as follows: 

Button Function

New Creates a new vector on the CMS server (or your PC 
ScratchPad).

Open... Displays the Select the Vector to Open window, 
allowing you to browse your Call Center World to 
find the vector you want to work with.

Save Saves your vector to the CMS Server (or PC 
ScratchPad) from which you opened it.

Print... Displays the standard Windows Print window.

Cut Removes the selected object and saves it to be 
pasted later.

Copy Makes a copy of the selected object to be pasted 
later.

Paste Pastes the object that was previously cut or copied.

Delete Removes an vector step (or comment) from the 
vector.

Undo Undoes the last action performed in this Vector 
Editor session.

Redo Redoes the last action that was undone in this 
Vector Editor session.

Zoom In Magnifies the vector display each time it is selected.

Zoom Out Decreases the magnification of the vector display 
each time it is selected.

Help Contents Opens the Help Topics window, and displays the 
table of contents. 
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Status indicators 4

These indicators on the status bar provide information about the current 
vector.

Menu bar 4 A common Windows convention. The menu bar lists the available drop-
down menus. This section identifies these menus: File, Edit, View, Insert, 
and Help.

This indicator … Displays …

Vector Location The words New Vector or a full path to an 
existing vector in your Call Center World (for 
example, /Call Center 
World/CMS20/ACD8/Vector 
Folder/Visual Vector).

Current Visual 
Steps 

A count of the number of palette icons in the 
current visual vector. The icon for the initial Start 
icon is not counted.

Current Stored 
Steps 

A count of the number of vector steps the current 
vector will occupy when stored on an ACD. The 
limit is 32 steps. At step 29, the steps turn yellow. 
At step 33, the steps turn red.
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File menu 4 The File menu has the following items: 

New
Creates a new EAS Vector; Non-EAS Vector; EAS, Non-Prompting 
Vector; or Non-EAS, Non-Prompting Vector on-line (or iyour ScratchPad).

Open...
Displays the Select the Vector to Open window, allowing you to browse 
your Call Center World to find the vector you want to work with.

Save
Saves your vector to the CMS (or ScratchPad) from which you opened it.

Save As...
Displays the Save Vector As window.

Print...
Displays the standard Windows Print window.

Properties
Accesses the Properties window for the selected object.

Close
Closes the Vector Editor tool’s window.
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Edit menu 4 The Edit menu has the following items.  

Undo
Undoes the last action performed in this Vector Editor session, up to four 
actions.

Redo
Redoes the last action that was undone in this Vector Editor session, up 
to four actions.

Cut
Removes the selected object and saves it to be pasted later.

Copy
Makes a copy of the selected object to be pasted later.

Paste
Pastes the object that was previously cut or copied.

Delete
Removes an vector step (or comment) from the vector.
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View menu 4 The View menu has the following items: 

Toolbar
Toggles showing the Vector Editor toolbar.

View Comments
Toggles showing the comments for the vector steps.

View Labels
Toggles showing the labels for the vector steps.

Layout...
Displays a window allowing you to change how vectors are laid out 
(oriented)..

Reset Zoom
Resets the zoom magnification to the default of 100 percent.

Zoom In
Magnifies the vector display each time it is selected.

Zoom Out
Decreases the magnification of the vector display each time it is selected.
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Insert menu 4 The Insert menu has the following items.  

Comments
Allows you to type free-floating comments and attach them to a visual 
vector. If you use a tool other than the Vector Editor to edit vectors, then 
your step comments will be detached from the vector steps and you will 
have to re-attach them.



  
Using the Vector Editor CentreVu® Visual Vectors Version 1.0 User Guide

Using the Vector Editor 4-21

Help 4 Press the F1 key or select the Help button to display context-sensitive 
help. Select Help from the menu bar to choose from the following options. 

Help Contents
Opens the Help Topics window, and displays the table of contents. 

About…
Opens the About… window, which shows the software version number. 
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Using Vector Editor Menus and Palettes 4

Vector Editor Menus 4 To select a Vector Editor menu item, choose any of the following 
methods: 

● Click on the item

● Use the arrow keys to highlight the item and then press Enter 

● Hold down the Alt key and press the underlined letter in the menu 
item you want to select

● Hold down the Ctrl key and press the key assigned to the operation. 
For example, use Ctrl+C to copy. 

Vector Step Palettes 4 Vector Steps are grouped in the following five palettes on the left-hand 
side of the Vector Editor window.

● Input/Output

— Announcement

— Timed Announcement

— Music

— Ringback

— Silence

— Reply

— Consider

— Collect

— Converse

● End

— Busy

— Stop

— Disconnect

● Test

— Caller Info

— Center Info

— Queue Activity

— Agent Activity

— Time of Day
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● Queue

— Queue Activity

— Center Info

— Agent Activity

— Queue Unconditional

● Routing

— Route To Number

— Route To Digits

— Adjunct Route

— Messaging Skill

— Goto Vector.

Help system 4 Press the F1 key or select the Help button to display context-sensitive 
help. Select Help from the menu bar to choose from the help options 
described in “Basic Framework Window Features” on page 2-6.
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Opening Vectors 4

Overview 4 Regardless of which window you use to select vectors, the actions that 
may be performed are the same. 
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Access procedures 4 To open a vector from the Vector Editor window, do the following:

1. Select the Open... menu item from the File menu.

Result
A Select the Vector to open window displays.

2. Browse your Call Center World and find the vector you want.

● Click the + icon next to a container (for example, a Vector 
Folder) to show objects contained within it (for example, 
vectors).

● If needed to reduce clutter, click the – icon to the left of a 
container to collapse the display and hide the objects within it.

3. Highlight the name of the vector you would like to access.
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4. Select the Open button.

Result

A graphical representation of the selected vector appears in the 
Vector Editor window.

In Navigator

Alternatively, you can double-click the vector in the Navigator tool, or 
right-click the vector and select Edit from the context menu.
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Features of the select 
object window 4

The Select the Vector to open window has the following features.

Open from 

Use this area to browse your Call Center World for the object you want.

Object Name

The name of the object you have highlighted in the Open from area. 

Of Type

This drop-down list box shows the type of object that is currently 
selected. 

Open and Cancel buttons 

The Open and Cancel buttons you see on this windows perform standard 
Windows actions.

● Open accepts the current input and displays the next window. 

● Cancel ignores the current input and returns you to the previous 
window. 
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Saving Vectors 4

Overview 4 Regardless of which window you use to select objects, the actions that 
may be performed are the same. 

Saving procedures 4 To save a vector from the Vector Editor window, do the following:

1. Select the Save As... menu item from the File menu.

Result
A Save Vector As window displays.
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2. Browse your Call Center World and find the container in which you 
want to save the current vector.

● Click the + icon next to a container (for example, a Vector 
Folder) to show objects contained within it (for example, 
vectors).

● If needed to reduce clutter, click the – icon to the left of a 
container to collapse the display and hide the objects within it.

3. Highlight the name of the container (ScratchPad or Vector Folder) 
you chose.

4. Select the Save button.

Result
A graphical representation of the selected vector is saved to the 
scratchpad, or the visual vector is converted and stored on the ACD 
containing the Vector Folder..

In Navigator

Alternatively, you can drag and drop one or more vectors in the Navigator 
tool.
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Features of the Save 
Object window 4

The Save Vector As window has the following features.

 

Save In

Use this area to browse your Call Center World for the container you 
want.

Object Name

The name of the object you have highlighted in the Save In area. 

Of Type

This drop-down list box shows the type of object that is currently 
selected. 

Save and Cancel buttons 

The Save and Cancel buttons you see on this windows perform standard 
Windows actions.

● Save accepts the current input and displays the next window. 

● Cancel ignores the current input and returns you to the previous 
window. 
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Using Step Property Windows 4

Purpose 4 Once you have selected properties from the context menu for an object, 
an input window displays. The information required in the input window 
depends on the object.

The following are described:
● “Basic features of fields on property windows” on page 4-32
● Properties of the “Announcement (Input/Output) step” on page 4-32
● Properties of the “Timed Announcement (Input/Output) step” on 

page 4-32
● Properties of the “Music (Input/Output) step” on page 4-33
● Properties of the “Ringback (Input/Output) step” on page 4-33
● Properties of the “Silence (Input/Output) step” on page 4-33
● Properties of the “Reply (Input/Output) step” on page 4-33
● Properties of the “Consider (Input/Output) step” on page 4-33
● Properties of the “Collect (Input/Output) step” on page 4-34
● Properties of the “Converse (Input/Output) step” on page 4-34
● Properties of the “Busy (End) step” on page 4-35
● Properties of the “Stop (End) step” on page 4-35
● Properties of the “Disconnect (End) step” on page 4-35
● Properties of the “Caller Info (Test) step” on page 4-35
● Properties of the “Center Info (Test) step” on page 4-36
● Properties of the “Queue Activity (Test) step” on page 4-37
● Properties of the “Agent Activity (Test) step” on page 4-37
● Properties of the “Time Of Day (Test) step” on page 4-38
● Properties of the “Queue Activity (Queue) step” on page 4-38
● Properties of the “Center Info (Queue) step” on page 4-39
● Properties of the “Agent Activity (Queue) step” on page 4-39
● Properties of the “Queue Unconditional (Queue) step” on page 4-40
● Properties of the “Route To Number (Routing) step” on page 4-40
● Properties of the “Route To Digits (Routing) step” on page 4-40
● Properties of the “Adjunct Route (Routing) step” on page 4-40
● Properties of the “Messaging Skill (Routing) step” on page 4-41
● Properties of the “Goto Vector (Routing) step” on page 4-41.
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Basic features of fields 
on property windows 4

Use the Property window features to enter or edit existing field values, as 
follows:

Announcement 
(Input/Output) step 4

The following describes the Announcement (Input/Output) step:

Timed Announcement 
(Input/Output) step 4

The following describes the Timed Announcement (Input/Output) step:

Feature Action

Text boxes Type in any characters from the keyboard for this 
field.

Drop-down 
lists

View and select from a list of the valid values 
available for this input field.

Numeric fields Type in numbers (depending on ECS/switch type 
and software version) as the valid entries for this 
input field.

Check Boxes Select the check box to toggle it on for yes or off for 
no.

Properties Description

Announcement Select a valid announcement for the ACD on which 
the step will be saved, or select Extension.

Extension Enter a 1-5 digit extension number. Default is 0. 
Disabled if Announcement is not Extension.

Comment A comment associated with this step.

Properties Description

Seconds Enter numeric value 0-999 (default=0).

Announcement Select a valid announcement for the ACD on which 
the step will be saved, or select Extension.

Extension Enter a 1-5 digit extension number.  Default is 0. 
Disabled if Announcement is not Extension.

Treatment Select music, silence, ringback, or continue. Default 
is continue.

Comment A comment associated with this step.
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Music (Input/Output) 
step 4

The following describes the Music (Input/Output) step:

Ringback 
(Input/Output) step 4

The following describes the Ringback (Input/Output) step:

Silence (Input/Output) 
step 4

The following describes the Silence (Input/Output) step:

Reply (Input/Output) 
step 4

The following describes the Reply (Input/Output) step:

Consider 
(Input/Output) step 4

The following describes the Consider (Input/Output) step:

Properties Description

Seconds Enter numeric value 0-999 (default=0).

Comment A comment associated with this step.

Properties Description

Seconds Enter numeric value 0-999 (default=0).

Comment A comment associated with this step.

Properties Description

Seconds Enter numeric value 0-999 (default=0).

I-Silent Check to enable.

Comment A comment associated with this step.

Properties Description

Comment A comment associated with this step.

Properties Description

Measure Split/Skill is the default value. Or select location from 
drop-down list, if applicable.

Split/Skill Select a split or skill (or First, Second, Third, or Id) 
from drop-down list. Disabled if Measure is Location.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Measure is Location or if Split/Skill is not Id.
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Collect (Input/Output) 
step 4

The following describes the Collect (Input/Output) step:

Converse 
(Input/Output) step 4

The following describes the Converse (Input/Output) step:

Priority High is the default value. Or select low, medium, or 
top from drop-down list. Disabled if Measure is 
Location.

Location Enter numeric value 1-255 (default=1). Disabled if 
Measure is Split/Skill.

Adjustment Enter numeric value 0-100 (default=0).

Comment A comment associated with this step.

Properties Description

Properties Description

Source Digits is the default value. Or select CED or CDPD 
from drop-down list, if applicable.

Number of 
digits

Enter numeric value 1-16 (default=1). Disabled if 
Source is not digits.

Comment A comment associated with this step.

Properties Description

Split/Skill Select a split or skill (or First, Second, Third, or Id) 
from drop-down list. Disabled if Measure is Location.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Priority High is the default value. Or select low, medium, or 
top from drop-down list. Disabled if Measure is 
Location.

Passing None is the default value. Or select vdn, ani, digits, 
qpos, wait, or data from drop-down list.

Data Enter up to a 6-digit number, if applicable (default is 
blank). Enabled if first Passing is Data.

Passing None is the default value. Or select vdn, ani, digits, 
qpos, wait, or data from drop-down list. Disabled if 
first Passing is none.
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Busy (End) step 4 The following describes the Busy (End) step:

Stop (End) step 4 The following describes the Stop (End) step:

Disconnect (End) step 4 The following describes the Disconnect (End) step:

Caller Info (Test) step 4 The following describes the Caller Info (Test) step:

Data Enter up to a 6-digit number, if applicable (default is 
blank). Enabled if second Passing is Data.

Comment A comment associated with this step.

Properties Description

Properties Description

Comment A comment associated with this step.

Properties Description

Comment A comment associated with this step.

Properties Description

Comment A comment associated with this step.

Properties Description

Measure ANI is the default value. Or select digits or ii-digits 
from drop-down list, if applicable.

Comparator Equals (=) is the default value. Or select <=, <>, <, >, 
>=, in , or not in, from drop-down list.

Threshold Zero (0) is the default value. Or enter a numeric 
value (1-16 characters if ani or digits, 00-99 if ii-
digits). Disabled if Comparator is in or not in.
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Center Info (Test) step 4 The following describes the Center Info (Test) step:

Table One (1) is the default value. Or enter a numeric 
value (1-100). Disabled if Comparator is not in or not 
in.

Comment A comment associated with this step.

Properties Description

Properties Description

Measure Counted-calls to VDN is the default value. Or select 
rolling-asa, expected-wait from drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, Best, 
Call, or Id) from drop-down list. Disabled if Measure 
is not expected wait.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Priority High is the default value. Or select low, medium, or 
top from drop-down list. Disabled if Measure is not 
expected wait, or if Split/Skill is Best or Call.

VDN Select a VDN (or extension, active, or latest) from 
drop-down list. Disabled if Measure is expected wait.

Extension Enter a 1-5 digit extension number.  Disabled if VDN 
is not unmeasured

Comparator Equals (=) is the default value.  Or select <=, <>, <, 
>, >=, from drop-down list.

Threshold One (1) is the default value.  Or enter a numeric 
value that depends on Measure and your 
ECS/switch software version.

Comment A comment associated with this step.
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Queue Activity (Test) 
step 4

The following describes the Queue Activity (Test) step:

Agent Activity (Test) 
step 4

The following describes the Agent Activity (Test) step:

Properties Description

Measure Rolling-asa is the default value. Or select calls-
queued, interflow-qpos, oldest-call, or wait-improved 
from drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, Id, or 
Best) from drop-down list. Disabled if Measure is 
interflow-qpos.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Priority High is the default value. Or select low, medium, or 
top from drop-down list.  Disabled if Measure is 
interflow-qpos or Split/Skill is Best.

Comparator Equals (=) is the default value.  Or select <=, <>, <, 
>, >=, from drop-down list.

Threshold One (1) is the default value. Or enter a numeric 
value that depends on Measure and your 
ECS/switch software version.

Comment A comment associated with this step.

Properties Description

Measure Available-agent is the default value. Or select 
staffed-agents from drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, or Id) 
from drop-down list.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Comparator Equals (=) is the default value. Or select <=, <>, <, >, 
>=, from drop-down list.

Threshold Zero (0) is the default value. Or enter a numeric 
value that depends on Comparator and your 
ECS/switch software version.

Comment A comment associated with this step.
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Time Of Day (Test) 
step 4

The following describes the Time Of Day (Test) step:

Queue Activity (Queue) 
step 4

The following describes the Queue Activity (Queue) step:

Properties Description

Start Day All is the default. Or select beginning day from the 
drop-down list. All if Finish Day is All.

Start Time Current time is default. Or enter beginning time of 
day in 24-hour format.

Finish Day All is the default. Or select ending day from the drop-
down list. All if Start Day is All.

Finish Time Current time is default. Or enter ending time of day 
in 24-hour format.

Comment A comment associated with this step.

Properties Description

Measure Rolling-asa is the default value. Or select calls-
queued, oldest-call, or wait-improved from drop-
down list.

Split/Skill Select a split or skill (or First, Second, Third, Id, or 
Best) from drop-down list. Disabled if Measure is 
interflow-qpos.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Priority High is the default value. Or select low, medium, or 
top from drop-down list.  Disabled if Split/Skill is 
Best.

Comparator Auto-selected default value. Read-only field.

Threshold One (1) is the default value. Or enter a numeric 
value that depends on Measure and your 
ECS/switch software version.

Comment A comment associated with this step.
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Center Info (Queue) 
step 4

The following describes the Center Info (Queue)step:

Agent Activity (Queue) 
step 4

The following describes the Agent Activity (Queue) step:

Properties Description

Measure Expected-wait is the available value.

Split/Skill Select a split or skill (or First, Second, Third, Best, 
Call, or Id) from drop-down list.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Priority High is the default value. Or select low, medium, or 
top from drop-down list. 

Comparator Auto-selected default value. Read-only field.

Threshold One (1) is the default value. Or enter a numeric 
value that depends on Measure and your 
ECS/switch software version.

Comment A comment associated with this step.

Properties Description

Measure Available-agents is the default value. Or select 
staffed-agents from drop-down list.

Split/Skill Select a split or skill (or First, Second, Third, or Id) 
from drop-down list.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Priority Low is the default value. Or select medium, high, or 
top from drop-down list.

Comparator Auto-selected default value. Read-only field.

Threshold Zero (0) is the default value. Or enter a numeric 
value that depends on Comparator and your 
ECS/switch software version.

Comment A comment associated with this step.
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Queue Unconditional 
(Queue) step 4

The following describes the Queue Unconditional (Queue)step:

Route To Number 
(Routing) step 4

The following describes the Route To Number (Routing)step:

Route To Digits 
(Routing) step 4

The following describes the Route To Digits (Routing) step:

Adjunct Route 
(Routing) step 4

The following describes the Adjunct Route (Routing) step:

Properties Description

Split/Skill Select a split or skill (or First, Second, Third, Id, or 
Best) from drop-down list.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Priority High is the default value. Or select low, medium, or 
top from drop-down list.  Disabled if Split/Skill is 
Best.

Comment A comment associated with this step.

Properties Description

Number Zero (0) is the default. Or enter a 1-16 digit number.

Coverage No is the default value. Or select yes from the drop-
down list.

Comment A comment associated with this step.

Properties Description

Coverage No is the default value. Or select yes from the drop-
down list.

Comment A comment associated with this step.

Properties Description

Extension Enter a 1-5 digit extension number. Default is blank.

Comment A comment associated with this step.
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Messaging Skill 
(Routing) step 4

The following describes the Messaging Skill (Routing)step:

Goto Vector (Routing) 
step 4

The following describes the Goto Vector (Routing) step:

Properties Description

Split/Skill Select a split or skill (or First, Second, Third, or Id,) 
from drop-down list.

Skill Id Enter numeric value 1-600 (default=1). Disabled if 
Split/Skill is not Id.

Extension Extension is the default. Or select active or latest.

Number Zero (0) is the default. Or enter a 1-5 digit extension 
number. Disabled if Extension is active or latest.

Comment A comment associated with this step.

Properties Description

Vector Select a valid vector for the ACD on which the step 
will be saved, or select Id.

Vector Id Enter the numeric Id of a valid vector to goto 
(default=1). Disabled if Vector is not Id.

Comment A comment associated with this step.
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Completing Input Fields 4

Options 4 You can complete an input field by doing one of the following:

● Enter the requested information in the text box. 

● Select the information from a drop-down list of valid entries. 

● Check a box for the input field. 
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Vector Scenarios 4

Overview 4 There are many tasks related to call vectoring that Visual Vectors 
software helps you perform.

Common scenarios may include:

● “Creating a new Goto vector” on page 4-43

● “Moving/copying or saving vectors to ACDs of differing types” on 
page 4-51.

Creating a new Goto 
vector 4

1. Start CentreVu Visual Vectors.

Result
The CentreVu Framework window appears.

2. In the CentreVu Framework window, select Vector (EAS) from the 
sub-menu for Vector Editor on the Tools menu or toolbar.

Result
The Vector Editor window appears for a New Vector with an empty 
(grey) box for the first step.

3. To start your new vector, you want processing to branch to a 
different vector for nighttime callers only. First, you must test for the 
time of day. On the left-hand side of the Vector Editor window, select 
the Test palette.

Result
The available icons for the Test palette are displayed.

4. Using the tooltips (if enabled), locate and select the Time Of Day 
icon, then drag the icon and drop it on the empty step box in the 
workspace area.

Result
A yellow box appears when you can drop the icon.

5. Select Properties  from the context (right-click) menu for the Time Of 
Day icon, or double-click the icon.

Result
The Properties of Time Of Day window appears with default values.

6. Select the Start Time: fields and enter 23: 00 and then select the 
Finish Time: fields and enter 5: 00

Result
Leading zeroes are discarded from numeric entries.
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7. Optionally, you may type a comment for this test in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this test icon 
changes to TOD All 23:00 to All 05:00.

8. Two arrows to empty step boxes now appear in the workspace. The 
solid arrow points to the next step if the test is true; the broken or 
dotted arrow points to the next step if the test is false. To make a 
Goto Vector step, select the Routing palette.

Result
The available step icons change to display icons for Routing.

9. Locate and select the icon in the palette for the Goto Vector step, 
then drag the icon and drop it on the empty step box for TRUE in the 
workspace area.

Result
A yellow box appears when you can drop the icon.

10. Select Properties  from the context (right-click) menu for the Goto 
Vector step icon, or double-click the icon.

Result
The Properties of Goto Vector window appears with the required 
field outlined in red.

11. Select the Vector ID: field and enter 2.

Result
The OK and Apply buttons are enabled in the Properties window.

12. Optionally, you may type a comment for this step in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this step icon 
changes to Vector 2.

13. Next, you need to disconnect weekend callers after playing an 
announcement. To test the weekend condition, select the Test 
palette again.

Result
The available icons for the Test palette are displayed.

14. Locate, select, and then drag and drop another Time Of Day icon 
onto the empty box for FALSE in the workspace area.

Result
A second conditional branch is created, with two arrows pointing to 
empty step boxes.
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15. Select Properties  from the context (right-click) menu for the Time Of 
Day icon, or double-click the icon.

Result
The Properties of Time Of Day window appears with default values.

16. Select Friday from the drop-down list of values for the Start Day: 
field, enter 20: 00 in the Start Time: fields, then select Monday from 
the drop-down list of values for the Finish Day: field, and enter 5: 00 
in the Finish Time: fields.

Result
Leading zeroes are discarded from numeric entries.

17. Optionally, you may type a comment for this test in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this test icon 
changes to TOD Fri 20:00 to Mon 05:00.

18. To specify the announcement to be played for weekend callers, 
select the Input/Output palette.

Result
The available icons for the selected palette are displayed.

19. Locate and select the Announcement icon, then drag and drop it on 
the empty step box for TRUE in the workspace area

Result
A yellow box appears when you can drop the icon.

20. Select Properties  from the context (right-click) menu for the 
Announcement icon, or double-click the icon.

Result
The Properties of Announcement window appears. The Extension: 
field is required.

21. Select the Extension: field and enter 84573.

Result
The OK and Apply buttons are enabled in the Properties window.

22. Optionally, you may type a comment for this icon in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this icon changes to 
Ext 84573.
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23. Now you want to disconnect the weekend calls. Select the End 
palette.

Result
The available step icons change to display End icons.

24. Locate and select the Disconnect icon, then drag and drop it on the 
empty box for TRUE in the workspace area.

Result
A yellow box appears when you can drop the icon. The Disconnect 
step icon ends this conditional branch.

25. Next, if the weekend condition tests false (the broken or dotted 
arrow), you want to queue the call. Select the Queue palette.

Result
The available step icons change to display Queue icons.

26. Locate and select the Queue Unconditional icon, then drag and drop 
it on the empty step box for FALSE in the workspace area.

Result
A yellow box appears when you can drop the icon.

27. Select Properties  from the context (right-click) menu for the Queue 
Unconditional icon, or double-click the icon.

Result
The Properties of Queue Unconditional window appears.

28. Select Id from the drop-down list of values for the Skill: field.

Result
The Skill Id: field is enabled and required.

29. Select the Skill Id: field and enter 1.

Result
The OK and Apply buttons are enabled in the Properties window.

30. Optionally, you may type a comment for this step in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this step icon 
changes to Skill 1.

31. Now you want callers to wait while hearing ringback. Select the 
Input/Output palette again.

Result
The available step icons change to display icons for Input/Output.
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32. Locate and select the Ringback icon, then drag and drop it on the 
empty step box in the workspace area.

Result
A yellow box appears when you can drop the icon.

33. Select Properties  from the context (right-click) menu for the 
Ringback icon, or double-click the icon.

Result
The Properties of Ringback window appears with a default value of 
0 seconds.

34. Change the highlighted default value to 18 in the Seconds: field.

Result
The Apply button is enabled in the Properties window.

35. Optionally, you may type a comment for this step in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this step icon 
changes to 18 secs.

36. Next, you want to collect a digit after playing an announcement for 
the caller. Locate and select the Announcement icon, then drag and 
drop it on the empty step box in the workspace area.

Result
A yellow box appears when you can drop the icon.

37. Select Properties  from the context (right-click) menu for the 
Announcement icon, or double-click the icon.

Result
The Properties of Announcement window appears. The Extension: 
field is required.

38. Select the Extension: field and enter 72349.

Result
The OK and Apply buttons are enabled in the Properties window.

39. Optionally, you may type a comment for this icon in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this icon changes to 
Ext 72349.



  
Using the Vector Editor CentreVu® Visual Vectors Version 1.0 User Guide

Using the Vector Editor 4-48

40. Locate and select the Collect icon, then drag and drop it on the 
empty step box in the workspace area.

Result
The label shows the default is to collect 1 digit, so you do not need 
to edit this icon’s default properties.

41. Now you want to route callers conditionally, based on the collected 
digit. You can add the condition later. Select the Routing palette.

Result
The available icons change to display vector step icons for Routing.

42. Locate and select the Route To Number icon, then drag and drop it 
on the empty step box in the workspace area.

Result
A yellow box appears when you can drop the icon.

43. Select Properties  from the context (right-click) menu for the Route 
To Number icon, or double-click the icon.

Result
The Properties of Route To Number window appears with default 
values.

44. Change the highlighted default value in the Number: field to 
93031234567.

Result
The Apply button is enabled in the Properties window.

45. Optionally, you may type a comment for this icon in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this icon changes to 
93031234567 no.

46. You must add the conditional branch, so select the Test palette.

Result
The available icons change to display Test icons.

47. Locate and select the Caller Info icon, then drag and drop the icon 
onto the arrow BEFORE the Route To Number icon in the 
workspace area.

Result
A yellow box appears when you can drop the icon between existing 
icons.
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48. Select Properties  from the context (right-click) menu for the Caller 
Info icon, or double-click the icon.

Result
The Properties of Caller Info window appears with default values.

49. Select digits from the drop-down list of values for the Measure: 
field.

Result
The Apply button is enabled.

50. Select the default value of 0 in the Threshold: field and change it to 
5.

Result
The highlighted value changes in the Properties window.

51. Optionally, you may type a comment for this icon in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this icon changes to 
DIG = 5.

52. There are now two empty step boxes in the workspace area. The 
true box (solid arrow) is the next step if the collected digit was 5; 
otherwise, the false box is next. If their collected digit was not 5, you 
want callers to wait while hearing music, so select the Input/Output 
palette. 

Result
The available icons change to display Input/Output icons.

53. Locate and select the Music icon, then drag and drop it on the empty 
box for FALSE in the workspace area.

Result
A yellow box appears when you can drop the icon.

54. Select Properties  from the context (right-click) menu for the Music 
icon, or double-click the icon.

Result
The Properties of Music window appears with a default value of 0 
seconds.

55. Change the highlighted default value to 30 in the Seconds: field.

Result
The Apply button is enabled in the Properties window.
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56. Optionally, you may type a comment for this step in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this step icon 
changes to 30 secs.

57. You want to play an announcement for callers every 30 seconds. 
Locate and select the Announcement icon, then drag and drop it on 
the empty box after the Music icon.

Result
A yellow box appears when you can drop the icon.

58. Select Properties  from the context (right-click) menu for the 
Announcement icon, or double-click the icon.

Result
The Properties of Announcement window appears. The Extension: 
field is required.

59. Enter 74934 in the Extension: field.

Result
The OK and Apply buttons are enabled in the Properties window.

60. Optionally, you may type a comment for this icon in the Comment: 
field, and then select OK.

Result
The Properties window closes and the label for this icon changes to 
Ext 74934.

61. Now to create a loop back to hearing music, drag the empty step 
box to the FALSE arrow immediately BEFORE the Music step icon.

Result
A solid line joins this arrow, showing the unconditional nature of this 
goto step.

62. Lastly, there is still an empty step box after the Route To Number 
icon. To finish editing your new vector, select the End palette.

Result
The available step icons change to display End icons.

63. Locate and select the Stop icon, then drag and drop it on the empty 
step box in the workspace area.

Result
A yellow box appears when you can drop the icon. The Stop step 
icon ends this conditional branch.
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64. If you haven’t already saved your work, select the Save item from 
the File menu or toolbar in the Vector Editor window.

Result
The first time you save, a window will appear in which you specify 
where to save the vector. This can be off-line in a scratchpad, or on-
line to a permitted ACD’s Vector Folder. If your vector is new on the 
ACD (you’re not saving using an existing vector’s name), you will be 
prompted for a Name and ID. If you saved an existing vector (or 
using its name), you will be prompted to overwrite it.

Moving/copying or 
saving vectors to 
ACDs of differing 
types 4

Important! 
You can move or copy vectors from one ACD to another using the 
Navigator tool. You can also open or create a vector of one type and save 
it to an ACD of a differing type, or copy and paste one or more steps 
between differing vectors using the Vector Editor tool. In these situations, 
vector steps need conversion.

1. Open an existing or create a new Vector (EAS) containing skill-
related properties of steps such as Queue Activity, Center Info, or 
Agent Activity and digit properties of steps such as Converse or 
Collect.

2. Copy the whole vector or set of steps described in the preceding 
step.

3. Open an existing or create a new Vector (non-EAS, non-Prompting)

4. Paste the whole vector or set of steps you previously copied.

5. You will be prompted with one or more windows explaining the 
necessary conversion(s). You may choose Yes to rectify 
incompatible steps individually, or Yes to All to rectify steps of the 
same type in all currently selected vectors/steps.
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Printing Vectors 4

Overview 4

4 This section describes how to print vectors and windows. Included are 
instructions for selecting a printer and specifiying that printer’s properties. 
This print function is available only in the Vector Editor part of Visual 
Vectors.

In this section 4 Topics include:

● Printing a Vector

● Print Windows.
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Printing a Vector 4

Selecting a printer 4 1. Select the Print item from the File menu in the Vector Editor window. 

2. Select the printer, print range, and number of copies

3. Specify any printer properties, as needed. 

4. Select OK.

Result
The printing status window displays. The time required will vary, 
depending on which vector you are printing.

Specifying printer 
properties 4

1. Select the Print item from the File menu in the Vector Editor window. 

2. Complete the Print window by filling in the input field(s).

3. Select the Properties button next to the Printer Name field..

4. Specify or change any options in the Printer Properties window, as 
needed.

5. Select OK.

Result
The Print window displays again and the Printer fields are populated 
with any inputs you have previously entered.

6. Select OK.

Result
The print operation runs.
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Print Windows 4

Purpose 4 The Print windows are provided by the Windows operating system. See 
your windows documentation or on-line help for further information.

Print window items 4 The following lists Print window items and a definition of each.

Window Item Function

Copies Specifies the number of copies to print.
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VDN Assignment Wizard 5

Overview 5

5 This chapter explains how to use the VDN Assignment tool.

It is divided into the following sections:

● VDN Assignment Overview

● Using the VDN Assignment Wizard.

See the overview of each section for a preview of the section’s contents.
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VDN Assignment Overview 5

Overview 5

5 To run the VDN Assignment Wizard, you need to start CentreVu 
Framework and connect to a CentreVu CMS server to access VDNs for 
one or more ACDs linked to the CMS. You may connect by choosing 
Connect from the File menu or toolbar in the CentreVu Framework 
window.

In this section 5 Topics include:

● Terms you need to know

● Starting the VDN Assignment Wizard

● Connecting to a CentreVu CMS server

● Adding new CMS servers

● Closing windows

● Disconnecting from a CentreVu CMS server

● Exiting the wizard.

Terms You Need to Know 5

Terms 5 Before you begin using the software, you should know the meaning of 
several terms. These terms, as well as others, are also defined in the 
Glossary.

Accelerator Keys  
Keys that provide shortcuts to actions available on the menu.

Automatic Call  Distribution (ACD) 
A switch feature using software that channels high-volume incoming and  
outgoing call traffic to agent groups (splits or skills).

Also an agent state where the extension is engaged on an ACD call.

See Redirect On No Answer and Auto-Available Split.
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Call Vectoring
A switch feature that provides a highly flexible method for processing 
ACD calls using VDNs and vectors as processing points between trunk 
groups and splits. Call vectoring permits treatment of calls that is 
independent of splits.

Similar to a computer program, a call vector is a set of instructions that 
control the routing of incoming calls based on conditions that occur in a 
call center environment. Examples of call vector conditions include time 
of day and the number of calls in queue.

Container 
An object in your Call Center World that logically contains other entities or 
objects. For example, each CMS object in your Call Center World can 
contain as many as 8 ACD objects, each of which contains entity folders 
(for announcements, split or skill objects, trunk groups, VDNs, and 
vectors).

Context menu 
A menu with specific actions for an entity or object.

CentreVu Visual Vectors window 
The window in which you are currently working (usually indicated by a 
highlighted title bar). Visual Vectors has a Framework window and 
windows for each of the tools, including Navigator, Vector Editor, and 
VDN Assignment Wizard.

Folder 
An object in the Navigator tool that contains entities (announcements, 
splits/skills, trunk groups, VDNs, and vectors). Folders are used to 
visually group all entities of a specific type for an ACD.

Input field 
An area in a window into which you enter one or more valid values. Valid 
values may be integers, for example, or names assigned in the CentreVu 
CMS Dictionary.

Menu bar  
A menu bar is under the title bar of most windows. The menu bar shows 
the menu names available for that particular window (for example, File 
and Help). You select an item from one of these drop-down menus.

Name (synonym) fields  
Fields in which you may enter a name (synonym) that has been assigned 
in the CMS Dictionary (for example, the name of a vector).



  
VDN Assignment Wizard CentreVu® Visual Vectors Version 1.0 User Guide

VDN Assignment Overview 5-4

Object 
Any item which may appear in your Call Center World through the 
Navigator tool. Objects can be containers of other objects or entities 
(VDNs folder), or an object may be an administerable entity itself (VDN).

Skill
An attribute that is assigned to an ACD Agent. Agent Skills can be 
thought of as the ability for an Agent with a particular set of skills to 
handle a call which requires one of those skills. In relationship to your call 
center, think of skill as a specific customer need/requirement or perhaps 
a business need of your call center. You will be defining your skills based 
on the needs of your customers and your call center.

Split
A group of extensions that receives special-purpose calls in an efficient, 
cost- effective manner. Normally, calls to a split arrive primarily over one 
or a few trunk groups.

Switch
A private switching system providing voice-only or voice and data 
communications services (including access to public and private 
networks) for a group of terminals within a customer’s premises.

Title bar 
A title bar is across the top of most windows. The title bar shows the 
name of that particular window (for example, Navigator). Titles of open 
tool windows will be listed on the Window menu of CentreVu Framework.

Toolbar 
A toolbar is under the menu bar of most windows. Toolbar icons 
represent actions you can perform.

Tools menu 
A drop-down menu on the CentreVu Framework menu bar that gives you 
access to the Navigator, Vector Editor, and VDN Assignment tools.

Tooltips 
Tooltips are available in most windows by placing the mouse cursor over 
an item for two seconds. Tooltips usually describe the actions performed 
by selecting an icon. Tooltips can be disabled on the Preferences window 
accessed from the File menu of CentreVu Framework.

VDN
See Vector Directory Number.

VDN Assignment 
The window that displays after you select it from the Tools menu or 
toolbar in the CentreVu Framework window. It consists of several dialog 
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boxes in sequence; for example, one filters and selects the VDNs you 
wish to assign, and another performs the assignment(s).

VDN Skill Preferences
Up to three skill(s) can be assigned to a VDN. Calls use VDN skills for 
routing based on your preference (as you administer it in the vector). 
VDN skill preferences are referred to in the vector as “1st,” “2nd,” or “3rd.”

A prioritized list of agent skills administered for a VDN that are required or 
preferred for the answering agent. VDN Skill Preferences represent the 
requirement that a call be routed to an ACD agent with a particular ability 
or set of abilities.

Vector
A list of steps that process calls in a user-defined manner. The steps in a 
vector can send calls to splits, play announcements and music, 
disconnect calls, give calls a busy signal, or route calls to other 
destinations. Calls enter vector processing via VDNs, which may have 
received calls from assigned trunk groups, from other vectors, or from 
extensions connected to the switch.

Vector Command  
A vector step that describes the action to be executed for a call (for  
example, Queue, check, disconnect).

Vector Directory Number (VDN)
An extension number that enables calls to connect to a vector for 
processing. A VDN is not assigned an equipment location. It is assigned 
to a vector. A VDN can connect calls to a vector when the calls arrive 
over an assigned automatic-in trunk group or when calls arrive over a 
dial-repeating (DID) trunk group and the final digits match the VDN. The 
VDN by itself may be dialed to access the vector from any extension 
connected to the switch.

Vector Editor 
This software tool, accessed from CentreVu Framework, allows you to 
create and edit vectors visually, by dragging and dropping icons 
representing commands from a palette and arranging them into vector 
steps in a work area. You can attach comments, change layout, and save 
and print the vectors.

Vector Step
One processing step in a vector. A vector step consists of a command 
and one or more conditions or parameters (properties of visual vectors).

Vector Step Condition
A condition accompanying a vector command that defines the 
circumstances in which the command will be applied to a call. To visually 
edit the condition, access the properties for the vector step.
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Starting the VDN Assignment Wizard 5

Procedure 5 Use the steps below to start VDN Assignment Wizard for Windows 95/98 
or Windows NT 4.0.

1. Select the Lucent CentreVu Visual Vectors program group from the 
Programs sub-menu of the Start menu.

2. Select the CentreVu Visual Vectors 1.0 item from the program 
group.

3. Select VDN Assignment Wizard from Framework’s Tools menu or 
toolbar.

Results

The Visual Vectors software application opens. The CentreVu 
Framework window displays. Although the software is now running, you 
are not yet connected to a CMS server.

Framework is Visual Vectors’ main window. You will use the toolbar 
buttons and pull-down menus to access tools, including Navigator, that 
contain information about ACD entities from the CMS server.

The following figure illustrates how the window appears before logging 
into the CMS server.
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Disconnecting and exiting the wizard 5

Procedure 5 To exit any window in the wizard, select the Cancel button, or press Esc 
on your keyboard.

To exit the software, select Exit from the File menu in the CentreVu 
Framework main window.The software automatically disconnects from 
any CMS servers to which you are connected and then closes CentreVu 
Framework window. A warning message appears if you have open tool 
windows.

If you try to close or exit the CentreVu Framework window and you have 
open tool windows, a warning message will be displayed. If you restart 
framework, it will attempt to restore the open windows and server 
connections. See “Disconnecting and exiting the software” on page 4-12
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Using the VDN Assignment Wizard 5

Overview 5

5 This section introduces you to VDN Assignment window features as they 
appear both before and after connecting to CentreVu CMS. Follow the 
instructions to — among other tasks — make VDN selections, use 
windows, and enter values in input fields.

In this section 5 Topics in this section include:

● Basic window features

● Using window features

● Using the VDN selector window

● Completing input windows

● Completing input fields on VDN property windows.



  
VDN Assignment Wizard CentreVu® Visual Vectors Version 1.0 User Guide

Using the VDN Assignment Wizard 5-9

Basic VDN Assignment Wizard Features 5

Overview 5 This section describes the VDN Assignment  window as it appears before 
you connect to a CMS server. This figure illustrates the window. 

System menu box 5 A common convention. The system menu box enables you to perform 
Windowsoperations, such as closing the current window or application. 

Title bar 5 A common convention. The title bar shows the name of the application. 

Minimize, 
maximize/restore and 
close buttons 5

A common convention. The buttons in the upper right-hand corner adjust 
the size of the current window, or close it. 
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Buttons 5 The windows contain buttons to help you complete your tasks.

These four buttons appear on the windows of the VDN Assignment 
Wizard:

Button Function

Cancel Closes the wizard without making or changing any 
assignments.

Back Displays the previous window in the wizard. 
Disabled on the first window.

Next/Edit Next accesses the next window in the wizard, or on 
the last window Edit accesses the properties window 
for one or more selected VDNs. Select OK to commit 
VDN Assignment changes for the selected ACD on 
CMS.

Help Accesses a help window about the current window. 
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Using VDN Assignment Windows 5

Overview 5 The following describes how to use the three windows that comprise the 
VDN Assignment Wizard.

Welcome window 5 To use the first window of the VDN Assignment Wizard, do the following:

1. Browse your Call Center World and find the ACD containing the 
VDNs you want. For example, double-click a CMS to explore ACDs.

● Click the + icon next to a CMS to show its ACDs. If you are not 
connected to a server, first double-click it and complete the 
Connect to server window. Then you can show its ACDs.

● If needed to reduce clutter, click the – icon to the left of a 
container to hide the objects within it. Hiding ACDs does not 
disconnect you from their CMS.

Result
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2. Select (for example, by clicking to highlight it) the ACD for which you 
wish to do VDN Assignment(s).

Result

3. Select the Next button to go to the next window in the wizard.

Result
The Selection window appears.

VDN Selection window5 To use the next window to select VDNs for which to make assignments, 
do the following:

1. Leave the Filter: text box blank if you want to display a list of all 
VDNs Available for Selection on the Selected ACD. 

Optionally, you may filter the list of VDNs Available for Selection by 
entering any of the following in the Filter: text box.

● 1 to 20 characters. Letters, numbers, underscores ( _), blanks, 
commas ( ,), periods ( .), and plus signs ( +) are valid. 
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Characters that are not allowed include backslash ( \), grave 
accent ( ‘), tilde ( ~ ), double quotes ( "), pipe symbol ( |).

● pattern-matching wildcards, such as

— ? (exactly one character)

— * (any number of characters, including none).

Entering characters or characters with wildcards restricts the VDNs 
displayed in the Available for Selection (Filtered): list box to those 
that partially or completely match your entry. For example, entering 
*Sales* would match and display available VDNs named Pre-
Sales, Sales, and Sales Split. Entering VDN*1 would match 
and display available VDNs named VDN1, VDN 201, and 
VDNSupport01X.

Result
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2. Select one or more VDNs you want to administer from the filtered list 
of VDNs Available for Selection, using any of the following methods: 

● Highlight the VDN in the Available for Selection: list box (for 
example, single-click it) select the down arrowhead ↓ button.

● Hold down the Ctrl key while you highlight each one of the 
VDNs that you want and then select the down arrowhead ↓ 
button.

● Hold down the Shift key while you highlight the first and last in a 
group of VDNs that you want and then select the down 
arrowhead ↓ button.

● Select the down arrowhead button with the horizontal line 
under it to move all VDNs in the filtered Available for Selection: 
list box to the Selected: list box.

You may deselect one or more VDN(s) by reversing any of these 
actions, for example using the up arrowhead button ↑ to move 
highlighted VDNs in the Selected: list box back to the Available for 
Selection: list box.

Result
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3. Select the Next button to go to the next window in the wizard.

Result
The Edit Assignment window appears.

Edit Assignment 
window 5

To use the last window of the VDN Assignment Wizard, do the following:

1. Confirm that the Selected ACD and Selected VDNs are correct.

Result
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2. Select the Edit button to assign the Selected VDN(s) to a vector or 
change other VDN object properties.

Result

If you selected one VDN, the property window for that VDN will show 
editable values in its property fields. If you selected many VDNs with 
the same values, the property window will show the common values 
in the property fields. If you selected many VDNs with different 
values, the property window will show blank property fields for you 
to complete.
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3. Select a Vector Id from the drop-down list of available vectors. If the 
Selected VDN(s) already are assigned to a vector, it is the default 
selection. 

If the selected VDN is not already assigned to a vector,, then 
[none] is the default. You cannont assign [none] to a vector. The 
[none] option unassigns VDNs.

Result
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4. Select one or more skill preferences from the drop-down lists of 
available skills (if the EAS feature has been purchased and enabled 
on the selected ACD). If the Selected VDN(s) already are assigned 
skill preferences, they are the default selections. If not, then [none] 
is the default. If you choose [none] for Skill Preference 1, then Skill 
Preference 2 and Skill Preference 3 also must be [none]. If you 
choose [none] for Skill Preference 2, then Skill Preference 3 also 
must be [none].  Note that choosing [none] will remove existing 
skill preferences from those selected VDNs that have them.

Result

5. Select the OK button to commit all the VDN Assignment(s) and any 
other changes to VDN properties and close the window. You may 
also select the Apply button to commit changes but leave the VDN 
Properties window open for further input.
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Troubleshooting 6

Overview 6

6 If you are having trouble with any of the procedures mentioned in this 
document, please read through this section before calling the National 
Customer Care Center or your Lucent representative. The problem may be 
something simple that you can quickly solve yourself.

If you have not solved the problem after reading this section, and you are a 
U.S. customer, then contact the National Customer Care Center at 1-800-
242-2121 (Lucent Technologies also offers fee-based installation 
consultation). Customers outside the United States should contact their 
Lucent Technologies representative or distributor.

If you have received an error message(s) in the course of a failed installation, 
then record the message(s) in order to assist National Customer Care Center 
personnel in diagnosing your problem.
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Troubleshooting FAQ 6

Overview 6 This section contains the answers to frequently asked questions (FAQ) 
that will help you with problems you may encounter when installing 
CentreVu Visual Vectors software, connecting to CentreVu CMS servers, 
or running CentreVu Visual Vectors tools.

 6 It contains the following topics:

● Installation, Uninstallation and Importance of the HOME variable

● Startup

● Connectivity

● Navigator

● Vector Editor

● VDN Assignment Wizard

● CentreVu Supervisor Integration

● Performance Issues

● Miscellaneous Issues

● General PC Issues.
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Installation, Uninstallation and Importance of the HOME variable 6

Purpose 6 Answers to questions about installing or uninstalling CentreVu Visual 
Vectors software are as follows:

There are several 
different installation 
programs. Which 
should I run? 6

Running setup.exe displays an Installation Type window for you to 
choose Local or Network. (You can run either setuplocal.exe or 
setupnetwork.exe.) Selecting Local runs setuplocal.exe to install 
Visual Vectors completely on one PC. Selecting Network runs 
setupnetwork.exe to install Visual Vectors on a network server to be 
shared by one or more users. After Network Installation, run 
setupclient.exe in the shared network folder from each user’s PC.

Why can’t I re-install 
Visual Vectors 
software? 6

Different installation variants (for example, Local, Network and Client) 
and versions (for example, VV1E.01 and VV1F.04) can be installed on 
the same machine, but the same version of the same variant cannot.

Why are my previous 
settings and offline 
objects missing? 6

There are a few possible causes:

● The user files (user.odb and user.odt in your .cvvv folder) are 
corrupt or have been deleted.
Solution: Try to restore a pair of backup copies from the last time 
you exited successfully (userBK1.odb and userBK1.odt) or the 
next to last time (userBK2.odb and userBK2.odt). To determine 
where your .cvvv folder is, see page 6-4. To restore, move (an) 
existing corrupt file(s) out of .cvvv, then copy the two backup files 
and rename them user.odb and user.odt.

● The user files (user.odb and user.odt) have been moved.
Solution: If possible, find out where the files have been moved to, 
and update the HOME variable to reflect the new location. For more 
details about the HOME variable, see page 6-4.

● The HOME variable has been changed.
Solution: Move the user files (user.odb and user.odt) to the new 
location specified by the HOME variable. For more details about the 
HOME variable, see page 6-4.
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Why can’t I uninstall 
from Control Panel’s 
Add/Remove 
Programs dialog box? 6

If CentreVu Visual Vectors appears on the list of programs available for 
uninstallation but fails when the uninstall takes place, it is likely that the 
installation log file, install.log, or required entries in the Windows Registry, 
are missing, invalid or corrupted.

If the application does not appear on the program list, it is likely that the 
installation program was executed from a machine other than the one 
where Visual Vectors software is installed. It is best to find out where the 
installation program was executed from and remove it from there via the 
Uninstall program (Unwise.exe). You can also try to re-install the 
software to the directory where it was previously located and then 
uninstall it. If these do not work, or the uninstall still fails, you must 
remove the software manually. This latter procedure requires careful 
removal of entries in the Windows Registry, and should be done only 
under the direction of a Lucent Technologies associate.

Why do I get a warning 
message about not 
having set the HOME 
environment variable 
on Windows NT? 6

CentreVu Visual Vectors software allows multiple users on Windows NT. 
By default, a HOME environment variable is not defined for each user in 
Control Panel’s System Properties window. A folder named .cvvv is 
created in the root folder of the drive on which Windows is installed (for 
example, C:\.cvvv). All users will access the same files, often causing 
conflicts. If a user variable named HOME is defined, then the folder 
storing user-specific files is created in the HOME folder (for example, 
H:\myhome\.cvvv ). If each HOME environment variable is unique for 
each Windows NT user, then data files will be unique. Please see your 
Windows documentation for more information about how to set the 
HOME environment variable.
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Startup 6

Overview 6 Answers to questions about starting to run CentreVu Visual Vectors 
software are as follows:

Why won’t Visual 
Vectors start? 6

There are a number of likely causes, look for these symptoms:

1. The Visual Vectors splash screen (resembling the Help About 
screen) does not appear and Visual Vectors does not start.

Applications can be checked (and processes in Windows NT) by 
pressing CTRL+ALT+DEL in Windows 95/98 (and also selecting 
Task Manager in NT). It is possible that one or more of the files (for 
example, vvjars.cfg, or .jar files) are missing. 

Solution: Call your Lucent Technologies support professional, 
representative or distributor, who has a list of all the folder 
structures, file content and distribution list. If any of these are 
missing, re-install Visual Vectors. If re-install fails, you will have to 
uninstall and then re-install Visual Vectors. If re-install fails, please 
refer to the uninstall failure section.

2. The process seems to start, but a message appears:
The user database is already in use. you can have only 1 user of 
this database at a time.

This is caused by two users trying to use the same user database at 
the same time, or the same user trying to run Centrevu Visual 
Vectors twice. Two different users could have the same HOME 
environment. Please see the HOME environment section for more 
information.

Solution: Define unique home variables for the users. Do not try to 
run one copy of Visual Vectors more than once.
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Connectivity 6

Overview 6 Answers to questions about connecting to a CentreVu CMS server 
running CentreVu Visual Vectors server software are as follows:

Why can’t I log into the 
CMS/Visual Vectors 
server? 6

Check the following for reasons why login to the server is refused:

● The login ID and/or the password are invalid or expired.

● Someone using the same login ID has already logged into the 
server. You will have the option of logging the other user out.

● The maximum number of users allowed to be logged into the CMS 
server has been reached.

I don’t get a login 
prompt at all. Why 
can’t I connect to a 
server? 6

There are a number of possible causes to check in the following order:

1. The client machine is not part of the network, for example, not 
physically plugged into the network or the network configuration 
(PPP connectivity, TCP/IP settings) is incorrect. You should receive 
an error message about not being able to find the server.

2. The server name is invalid. Try to “ping” it from MS-DOS (Windows 
95/98) or a Command Prompt (Windows NT).

3. The CentreVu CMS or Visual Vectors Server software has not been 
started. Please refer to your server documentation for more 
information.

4. The Orbix Daemon or OrbixNames service have not been started on 
the server. Please refer to your server documentation for more 
information on checking these items.

What should I do if the 
connection to the 
server is lost? 6

If you’ve tried reconnecting to it unsuccessfully, check the following:

1. The CMS server hardware/software is running. If not, restart it.

2. The Visual Vectors Server software is still running. If not, restart it. 
Please refer to your server documentation for more information.

3. Your client machine is still part of the network; for example, no one 
has kicked the network cable.
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Navigator 6

Overview 6 Answers to questions about using the Navigator tool in CentreVu Visual 
Vectors Client software are as follows:

Why can’t I see (or 
select) some of the 
items on the context 
menu? 6

Users may not have permission to perform some operations for (a) 
particular object(s). For example, if you do not have write permission to 
either an ACD (or to Call Center Administration), then the New option will 
not appear in the Vector Folder context menu for that ACD.

My off-line objects are 
missing, where are 
they? 6

Refer to “Why are my previous settings and offline objects missing?” 
located in the Installation and Unistallation section.

Why can’t I view my 
vector as ASCII text? 6

You may be looking at an off-line vector. The View As ASCII option exists 
only for vectors that have been stored on an ACD.
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Vector Editor 6

Overview 6 Answers to questions about using the Vector Editor tool in CentreVu 
Visual Vectors Client software are as follows:

Where are the step 
properties and 
comments in my 
vector printout? 6

The vector step properties and comments are not printed.

Why are the ASCII and 
graphical versions of 
my vector different? 6

This generally occurs because the vector has been modified recently and 
not save. Save the vector and then select View As ASCII again for the 
vector.

Why isn’t Save 
enabled in the Vector 
Editor? 6

Users may not have write permissions for the vectors. However, a Save 
As... action can be performed to copy the vector to a different location for 
which the user does have permission.

When I save my vector, 
all the open property 
boxes disappear. What 
happened? 6

When a vector is saved, all the open vector step property windows will be 
dismissed. Only the changes in committed property boxes (for example, 
having had the Apply button selected), will be saved; other changes to 
property values not yet committed will be discarded.

Why can’t I drag 
floating comments 
with vector steps? 6

When a group of vector steps and floating comments are selected and 
dragged, the comments cannot be dragged with the steps. However, 
cutting or copying the selected group is fine. This also applies to a 
selected group of floating comments. Only one comment at a time may 
be dragged.
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What can I do if I am 
editing a vector and 
the connection is lost?6

It depends on which connection has been dropped:

● If the connection to a CMS goes down (for example, the CMS server 
has crashed), then the user must save on-line vectors to an off-line 
scratch pad or to an ACD on another CMS. A message notifies the 
user of this. Because valid vector conversion from on-line to off-line 
and from one ACD to another require information from the CMS 
server, steps may be changed when saving vectors this way.

● If the ACD link goes down (for example, the Visual Vectors Server 
software has crashed), the user will be presented with a choice of 
saving the vector being edited to another location or exit from the 
editor. The vector being edited can be saved to another ACD or to 
an off-line scratchpad.
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VDN Assignment Wizard 6

Overview 6 Answers to questions about using the VDN Assignment tool in CentreVu 
Visual Vectors Client software are as follows:

Why can’t I see my 
VDNs from the filtered 
list? 6

1. Check to be sure no extra spaces or dots have been accidentally 
entered in the filter.

2. Check that the user has permissions for the VDNs and the ACD 
containing them.

Why can’t I see the 
ACD that I want? 6

The ACD may not have Call Vectoring enabled. In order to be able to 
select an ACD, it must have Call Vectoring enabled and the user must 
have permission for the ACD.
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CentreVu Supervisor Integration 6

Overview 6 Answers to questions about integrating your CentreVu Supervisor 
software into CentreVu Visual Vectors Client software are as follows:

Why isn’t the CentreVu 
Supervisor icon 
displayed on the 
CentreVu Framework 
toolbar, when I have a 
local installation of 
Supervisor software 
on the same PC as the 
Visual Vectors 
software? 6

Follow these steps in order to diagnose the problem:

1. What version of Supervisor do you have installed?

● Version 6 (or greater)? Continue with Step 2.

● Older version? Upgrade your copy of Supervisor software to at 
least version 6 and try again.

2. Check that you can run Supervisor by itself (for example, from the 
Start Menu).

● Yes? Continue with Step 3.

● No? Reinstall Supervisor and try again.

3. When installed, Supervisor setup writes a configuration file in the 
Windows folder %WINDIR% (for example, C:\Windows, 
D:\Winnt), named cvsup.cfg that contains a single line of plain 
text that is the path to Supervisor’s executable file. Confirm that the 
file %WINDIR%\cvsup.cfg exists, and contains only the path to the 
executable file (any text editor such as Notepad can be used to 
inspect the contents of cvsup.cfg).

● Yes? Contact your Lucent Technologies support professional, 
representative or distributor.

● No? Reinstall Supervisor and try again. If this fails to solve the 
problem, contact your Lucent Technologies support 
professional, representative or distributor.
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Why isn’t the CentreVu 
Supervisor icon 
displayed on the 
CentreVu Framework 
toolbar if I have a client 
installation of the 
Supervisor software 
on the same PC as the 
Visual Vectors 
software? 6

Follow these steps in order to diagnose the problem:

1. What version of Supervisor do you have installed?

● Version 6 (or greater)? Continue with Step 2.

● Older version? Upgrade your copy of Supervisor software to at 
least version 6 and try again.

2. Check that you can run Supervisor by itself (for example, from the 
Start Menu).

● Yes? Continue with Step 3.

● No? Reinstall Supervisor and try again.

3. The main program files for Supervisor are installed on a networked 
drive. Ensure that there is network connectivity between the local 
and networked drive (for example, can you browse to the drive using 
Windows Explorer?)

● Yes? Reinstall Supervisor and try again. If this fails to solve the 
problem, contact your Lucent Technologies support 
professional, representative or distributor.

● No? Contact your Network or System Administrator to help 
restore the network connectivity.
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Performance Issues 6

Overview 6 Answers to questions about the performance of your CentreVu Visual 
Vectors Client software are as follows:

Why isn’t the 
application more 
responsive? 6

There are a number of possible causes of responsiveness issues:

● The hard disk is thrashing (frequent hard disk access).

This indicates that the machine does not have enough memory. In 
our experience, 64MB of memory provides optimal performance.

Solution: Add more physical RAM.

● Too many application programs are open.

This makes less physical memory available to Visual Vectors, 
especially when memory intensive operations are running.

Solution: Close down other applications to provide more memory for 
Visual Vectors.

Solution: Add more physical RAM.

● The network link is slow.

Visual Vectors may be connected to the server via a slow 
connection.

Solution: Use a faster network link or a higher-speed modem.

Why isn’t deleting an 
object in the Navigator 
instantaneous? 6

When an object is deleted, the Navigator makes a copy of it, so the 
delete operation can be undone.

Why isn’t viewing 
some objects in 
Navigator 
instantaneous? 6

The first time after you log into a CMS server and Navigate any ACDs 
VDN Folder, permission-checking is performed (if it is enabled). The 
delay depends on the CMS server platform and the number of measured 
VDNs, but can range from one second to more than a minute. For delay 
estimates, see Chapter 1.
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Miscellaneous Issues 6

Overview 6 Answers to miscellaneous other questions about CentreVu Visual 
Vectors Client software are as follows:

Why does the software 
seem to hang, with the 
cursor in the wait 
state? 6

The application may not have actually hung; sometimes the cursor stays 
in the wait state even after a task has completed. If the cursor is moved, it 
will turn back to its normal state.

If a task takes place in the normal fashion, the progress bar should 
appear on screen, showing progress on work being done, and then 
disappear. If a task hangs, the progress bar should stay on the screen for 
some period of time with no progress reported. In this case, moving the 
cursor is usually not possible.

Why does Visual 
Vectors need Microsoft 
Internet Explorer 3.02 
or later to work? 6

Help in Visual Vectors has been implemented using HTML Help which 
requires Internet Explorer 3.02 or later to work. It must be installed, but it 
does not have to be set as the default browser (or application for .htm 
files).

I have IE 3.02 or later. 
Why doesn’t Visual 
Vectors Help appear to 
work? 6

There are a few causes which could prevent help from working:

● The help file, for example, vv_en.chm (the English version), is 
missing or corrupted.

Solution: Copy this file from another working software installation or 
re-install Visual Vectors.

● The help registry entries have been removed or corrupted.

Solution: Run hhupd.exe to setup the registry for HTML Help.

● The installation program was executed from another machine, 
hence the registry entries for help on this PC are missing (for more 
details, see page 6-3).
Solution: Run hhupd.exe to setup the registry for HTML Help.



  
Troubleshooting CentreVu® Visual Vectors Version 1.0 User Guide

6-15

Why does the 
application fail to 
repaint the screen or 
respond to any input? 6

Something in your PC environment could be causing this symptom. 
These problems may occur as General Protection Faults (GPFs), lockups 
or other mixed behavior. To determine if this type of problem exists, do 
the following:

1. Move everything out of your StartUp group.

2. Restart Windows.

3. Run Visual Vectors (making sure it is the only application running).

● If the problem does not go away, please provide the following 
to your Lucent Technologies support professional, 
representative or distributor: the error log (error.log) and 
trace log (trace.log) files, together with any useful 
information you can gather (for example, your operating 
environment and other PC applications, Visual Vectors 
installation type (Local or Network/Client), activity when Visual 
Vectors stopped responding, and so on).

● If the problem goes away, then another software application is 
causing your PC to have this problem. Continue with the next 
step.

4. Start running each file that was in your StartUp group.

If you still encounter problems, then you will not be able to run this 
software at the same time you are running Visual Vectors. You 
should speak with the manufacturer of this package to determine 
why it is causing a problem in your PC environment.

Why has the software 
crashed and what 
should I do? 6

If all else fails, please send the log files (error.log and trace.log) 
and the user files (user.odb and user.odt) to your Lucent 
Technologies support professional, representative or distributor, together 
with any useful information you can gather. This information might 
include, for example, your operating environment and other PC 
applications, Visual Vectors installation type (Local or Network/Client), 
activity when Visual Vectors crashed, and so on.
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General PC Issues 6

Overview 6 Answers to questions in general about using CentreVu Visual Vectors 
Client software on your machine are as follows:

Why is accessing my 
hard drive so slow? 6

A fragmented hard disk leads to slow disk access.

Be sure to run a defragmentation utility such as DEFRAG.EXE (Windows 
95/98 only; other optional defragmentation utilities are available for 
Windows NT 4.0), this will speed up disk access.

Important: do not run any defragmentation operation while using Visual 
Vectors (or any applications which require disk access), as this can lead 
to file corruption.

Why is it necessary to 
access my hard drive 
so much? 6

To determine if a problem exists, do the following:

1. Check your Windows swap file configuration. (For example, check 
Virtual Memory settings by right-clicking on the My Computer 
Desktop icon and selecting Properties.  Click on the Performance 
tab and check Virtual Memory settings.)

● If recommended settings are selected, continue with Step 2.

● If recommended settings are not selected, then allocate more 
Virtual Memory and restart Windows.

2. Check free space of the drive on which Windows is installed. (A full 
hard disk can create a bottleneck because there may not be 
sufficient space to generate an optimal swap file.)

●  If 50 MB or more is free, continue with Step 3.

● If less than 50 MB is free, free more space and restart 
Windows.

3. Check your memory in Windows. At least 64MB of physical RAM is 
needed for optimal performance, although more may well be 
required.

Do you think I might 
have some kind of 
virus? 6

Viruses typically hook disk and memory access routines.  This can cause 
performance problems.  Use a good virus-checking package to scan for 
and remove viruses.  Run it regularly. However, for best performance, do 
not run it at the same time that you are using Visual Vectors software.
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Glossary

Accelerator Keys  
Keys that provide shortcuts to actions available on the menu.

Access Permissions
Permissions assigned to a user so that the user can access different areas of 
a server or administer specific entities (for example, splits/skills, trunk 
groups, vectors, and VDNs) of an ACD. Access permissions are specified as 
read or write permission. Read permission means the user can access and 
view data. Write permission means the user can add, modify, or delete data 
and execute processes.

ACD 
See Automatic Call Distribution.

Active VDN Calls 
Also known as counted-calls to VDN. A Call Vectoring capability available 
with G3V4 or later switches. Counted-calls to VDN is a parameter of the go 
to step and go to vector commands that provides conditional 
branching (to a different step in the same vector or to a different vector) 
based on the number of incoming trunk calls a VDN is currently processing in 
a vector or at an agent.

Agent 
A person or VRU port that answers calls to an ACD split/skill. The agent  is 
known to CMS by a login identification keyed into a voice terminal.

Agent Login ID
A 1- to 4-digit number (Generic 2) or a 1- to 9-digit number (Generic 3) 
entered by an ACD agent from a voice terminal to activate the agent position. 
Agent logins are required for all CMS-measured ACD agents.

Agent Skill 
An attribute that is associated with an ACD agent. Agent Skills can be 
thought of as the ability for an agent with a particular set of skills to  handle a 
call that requires one of a set of skills. An agent can be assigned  up to 20 
skills. The meaning of each Agent Skill is defined by the customer. Examples 
of what could be considered skills are: the ability to speak a particular 
language or the expertise to handle a certain product.

See Primary Skill, Secondary Skill, and Skill Level.
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Announcement 
A recorded voice message that normally tells the caller what destination  
the call has reached. The announcement also often tries to persuade the  
caller to stay on the line. With Call Vectoring, announcements can be part  
of a vector’s call processing. An announcement is assigned to a vector by  
entering an announcement number.

Automatic Call  Distribution (ACD) 
A switch feature using software that channels high-volume incoming and  
outgoing call traffic to agent groups (splits or skills).

Also an agent state where the extension is engaged on an ACD call.

See Redirect On No Answer and Auto-Available Split.

Call Center World 
A collection of objects and entities that can be viewed and administered 
through CentreVu Framework. What you can access, edit or assign 
depends on your permissions.

Call Management System  (CMS) 
A software product used by business customers that have Lucent  
Technologies telecommunications switches/ECS and receive a large  
volume of telephone calls that are processed through the Automatic Call  
Distribution (ACD) feature of the switch/ECS. The CMS collects call-
traffic  data, formats management reports, and provides an administrative 
interface to the ACD feature in the switch/ECS.

Call Prompting 
A switch feature that routes incoming calls based on information entered  
by the calling party, such as an account number. The caller receives an  
announcement and is prompted to select an option from those listed in  
the announcement.

Call Vectoring
A switch feature that provides a highly flexible method for processing 
ACD calls using VDNs and vectors as processing points between trunk 
groups and splits. Call vectoring permits treatment of calls that is 
independent of splits.

Similar to a computer program, a call vector is a set of instructions that 
control the routing of incoming calls based on conditions that occur in a 
call center environment. Examples of call vector conditions include time 
of day and the number of calls in queue.

CentreVu Advocate
A set of features designed to enhance call and agent selection within a 
call center. CentreVu Advocate requires CentreVu Supervisor Version 6, 
DEFINITY ECS R6, and Expert Agent Selection. See CentreVu Advocate 
User Guide, 585-215-855 for more information.
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CentreVu CMS
See Call Management System.

CentreVu Framework 
The Visual Vectors software window from which you access tools such as 
Navigator, Vector Editor, and VDN Assignment. You can also use 
Framework File menu items to Connect to or Disconnect from CentreVu 
CMS servers.

CentreVu Supervisor
The Call Management System client application for the Microsoft 
Windows operating environment.

CentreVu Visual Vectors window 
The window in which you are currently working (usually indicated by a 
highlighted title bar). Visual Vectors has a Framework window and 
windows for each of the tools, including Navigator, Vector Editor, and 
VDN Assignment.

Container 
An object in your Call Center World that logically contains other entities or 
objects. For example, each CMS object in your Call Center World can 
contain as many as 8 ACD objects, each of which contains entity folders 
(for announcements, split or skill objects, trunk groups, VDNs, and 
vectors).

Context menu 
A menu with specific actions for an entity or item.

Current window 
The window in which you are currently working (usually indicated by a 
highlighted title bar).

Data Collection Off
CMS is not collecting ACD data. If you turn off data collection, CMS will 
not void data on current call activity.

Data Collection On 
CMS is collecting ACD data.

Database 
A group of files that store ACD data according to a specific time frame:  
current and previous intrahour real-time data and intrahour, daily, weekly,  
and monthly historical data.
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Database Item 
A name for a specific type of data stored in one of the CMS databases. A  
database item may store ACD identifiers (split numbers or names, login  
IDs, VDNs, etc.) or statistical data on ACD performance (number of ACD  
calls, wait time for calls in queue, current states of individual agents, 
etc.).

Database Tables 
CMS uses these tables to collect, store, and retrieve ACD data. Standard  
CMS items (database items) are names of columns in the CMS database  
tables.

Date Format
The standard format for entering dates on Supervisor reports. 

Acceptable formats are:

● Month/day/year (for example, 3/21/93).

● A “-” offset based on today's date (for example, -1 for yesterday). 
You can also enter a range of numbers (for example, 0 through -7).

● Separating individual data entry items using a semicolon (for 
example, 3/21/93;3/23/93;3/25/93)

● Entering ranges by placing a hyphen between entries (for example, 
3/21/93-3/25/93).

When you specify a date for a weekly report, that date or range of dates 
must correspond to the week start day selected in the System Setup-
Storage Intervals window. If the date and day do not match, the message 
No records found displays in the status line.

The month start date must be the first day of the month.

Delete 
An action that removes the entry on the window from the database.

Dictionary
A CMS subsystem that can be used to assign names to various call 
center elements such as login IDs, splits/skills, trunk groups, VDNs and 
vectors. These names appear on reports, making them easier to 
interpret.

EAS 
See Expert Agent Selection.
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Entity 
A generic term that refers to one of the following: Announcement, 
Split/Skill, Trunk Group, VDN, or Vector. Entities that CentreVu Visual 
Vectors can view or administer include Vectors and VDNs. Entity names 
are obtained from the CentreVu CMS Dictionary; renaming entities using 
Visual Vectors results in changes to the CMS Dictionary.

Error Message 
A response from a program indicating that a problem has arisen or  
something unexpected has happened, requiring your attention.

Expert Agent Selection (EAS)
Expert Agent Selection (EAS) is an optional switch feature that builds on 
the power of the Call Vectoring and ACD features of the switch to match 
the skills required to handle a particular call to an agent who has at least 
one of the skills that a caller requires. The ACD queuing and the Queue 
and Check  vector commands are used to route a call to an agent with 
the appropriate skill to handle that call. With EAS, call distribution is 
based on skill.

CentreVu CMS collects data on skills in the same manner as it collects 
data on splits.

CentreVu CMS also reports VDN data by VDN skill preference, so that 
customers can assess the call center performance relative to calls 
requiring particular skills. CMS reports how many calls were handled, 
how long these calls waited for service, and the average talk time for calls 
queued to a particular skill preference in a particular VDN.

Folder 
An object in the Navigator tool that contains entities (splits/skills, trunk 
groups, VDNs, and vectors). Folders are used to visually group all 
entities of a specific type for an ACD.

Historical Database
Contains intrahour records for up to 62 days, daily records for up to 5 
years, and weekly/monthly records for up to 10 years for each CMS-
measured agent, split/skill, trunk, trunk group, vector, and VDN.

INFORMIX
A relational database management system used to organize CMS 
historical data.

INFORMIX SQL
The interactive interface typically used to view the INFORMIX database.
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Integrated Services Digital Network (ISDN)
A digital standard for telephony that enables, among other things, 
telephone, television, and computer signals on the same lines. This 
system may someday replace our existing telephone lines.

ISDN 
See Integrated Services Digital Network.

LAN 
See Local Area Network.

Local Area Network
A private interactive communication network that allows computers to  
communicate over short distances, usually less than one mile, at high  
data transfer rates from 1 Mbps to as high as 100 Mbps.

Logical Agent
An EAS feature that associates the agent’s login ID with the physical 
extension when the agent logs in. Properties such as the assigned skills, 
class of restriction, and coverage path are associated with the login ID 
rather than the physical extension. This allows agents to log in at any 
available set.

Agents are assigned a single set of work mode buttons, rather than one 
set per skill. This simplifies the agent’s interface to the work mode 
buttons. When the “MI” or “AI” button is lit, the agent is available to take a 
call in any assigned skills.

The Logical Agent capability allows calling agents to connect by dialing 
into their login IDs. Calls to login IDs may be treated as direct agent ACD 
calls, given the proper class of restriction, or may be treated as extension 
(personal) calls. Treating the calls as direct agent calls can be used to 
help distinguish business-related from personal calls.

Look Ahead Interflow  (LAI) 
A switch feature that can be used to balance the call load among multiple 
call centers. The LAI feature works with Call Vectoring and ISDN PRI 
trunks to intelligently route calls between call centers. This allows 
multiple call centers to share work loads, expands hours of coverage, 
and allows calls to be transparently handled by call centers in different 
time zones.

Measured
A term that means an ACD entity (agent, split/skill, trunk, trunk group, 
vector, VDN) has been identified to CMS for collection of data. If the ACD 
element is not measured, no data is collected.
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Menu bar  
A menu bar is under the title bar of most windows. The menu bar shows 
the menu names available for that particular window (for example, File 
and Help). You select an item from one of these drop-down menus.

Message Windows
Temporary windows used only for displaying information like syntactical 
field errors.

Multiuser Mode
Any administered CMS user can log into CMS. Data continues to be 
collected if data collection is “on.”

Name (Synonym) Fields
Fields in which you may enter a name (synonym) that has been entered 
in the CMS Dictionary (for example, names of splits/skills, trunk groups, 
vectors, VDNs).

Navigator 
A window that displays after you select it from the Tools menu or toolbar 
in the CentreVu Framework window. It consists of two panes: a 
hierarchical “tree” view of your Call Center World on the left and a list of 
objects or entities on the right.

Nonprimary Split/Skill
When a call is queued to multiple splits/skills, the second and third 
splits/skills to which the call queues in a VDN are called nonprimary 
splits/skills. They are also referred to as secondary and tertiary 
splits/skills, respectively.

Object 
Any item which may appear in your Call Center World through the 
Navigator tool. Objects can be containers of other objects or entities 
(VDNs folder), or an object may be an administerable entity itself (VDN).

Primary Skill
Skills assigned to an agent. Primary skills are the areas in which the 
agent has the most expertise.

See also Agent Skill.

Pseudo-ACD 
An area you create on your CMS to place previously backed-up ACD  
data. A pseudo-ACD is not a live (real) ACD and does not communicate  
with any switch.

Queue
A holding area for calls waiting to be answered in the order in which they 
were received. Calls in a queue may have different priority levels, in 
which case, calls with a higher priority are answered first.
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QUEUED
A trunk state. An ACD call has seized the trunk and is queued to a 
split/skill waiting for an agent to answer.

Read Permission
The CMS user can access and view data (for example, run reports or 
view the Dictionary subsystem). Read permission is granted from the 
User Permissions subsystem.

Real-Time Database
Consists of the current and previous intrahour data on each CMS-
measured agent, split, trunk, trunk group, vector, and Vector Directory 
Number (VDN).

ScratchPad
The Default ScratchPad name is a container area on your PC designed 
to save vectors off-line when a switch/ECS link or CMS connection is not 
available. You can create a hierarchy of sub-folders under the default 
folder by selecting New ScratchPad from Navigator’s File menu.

Secondary Skill 
Skills assigned to an agent. Secondary skills are the areas in which the  
agent does not have extensive expertise, or is not the agent’s preference.  
(Used in G3V2 through G3V4 with EAS.)

See Agent Skill, Skill Level.

SEIZED
A trunk state. A call is using the trunk either incoming or outgoing.

Service Observing-VDNs
A feature available with G3V4 or later switches that gives a voice terminal 
user the ability to monitor the treatment a call receives as it is processed 
by a VDN.

Single-User Mode
Only one person can log into CMS. Data continues to be collected if data 
collection is “on.” This mode is required to change some CMS 
administration.

Skill
An attribute that is assigned to an ACD Agent. Agent Skills can be 
thought of as the ability for an Agent with a particular set of skills to 
handle a call which requires one of those skills. In relationship to your call 
center, think of skill as a specific customer need/requirement or perhaps 
a business need of your call center. You will be defining your skills based 
on the needs of your customers and your call center.
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Skill Hunt Group 
When EAS is enabled, calls route to specific skill hunt groups. These skill  
hunt groups are usually based on the needs of your customers. Agents  
are not assigned to a skill group (like split hunt groups), but agents are 
assigned specific skills that become active when they log in to their voice 
terminal.

Skill Level 
A priority level from 1 (highest) to 16 (lowest) indicating an agent’s level 
of  expertise or ability to handle calls to the given skill. (ECS Version 5 
and later.)

Split
A group of extensions that receives special-purpose calls in an efficient, 
cost- effective manner. Normally, calls to a split arrive primarily over one 
or a few trunk groups.

Staffed Agent
An agent who is currently logged in to the switch.

Station
An unmeasured extension. An extension that is not currently staffed by 
an agent or that is a member of an unmeasured split/skill or hunt group.

Status bar 
A status bar is across the bottom of some windows. The status bar shows 
information about the current action in that window.

Switch
A private switching system providing voice-only or voice and data 
communications services (including access to public and private 
networks) for a group of terminals within a customer’s premises.

Tertiary Split/Skill
Generic 3 with vectoring, Generic 2.2 with EAS only. When a call is 
queued to multiple splits/skills, the third split/skill the call queued to in a 
VDN is called the tertiary split/skill.

Time Format
The standard format for entering times on CMS reports. 

Acceptable formats are:

● AM/PM format (for example, 7:30AM-5:00PM).

● Military time format (for example, 7:30-17:00).

Title bar 
A title bar is across the top of most windows. The title bar shows the 
name of that particular window (for example, Navigator). Titles of open 
tool windows will be listed on the Window menu of CentreVu Framework.
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Toolbar 
A toolbar is under the menu bar of most windows. Toolbar icons 
represent actions you can perform.

Tooltips 
Tooltips are available in most windows by placing the mouse cursor over 
an item for two seconds. Tooltips usually describe the actions performed 
by selecting an icon.

Trunk
A telephone circuit that carries calls between two switches, between a 
Central Office (CO) and a switch, or between a CO and a phone.

Trunk Group
A group of trunks that are assigned the same dialing digits - either a 
phone number or a Direct Inward Dialed (DID) prefix.

Universal Call Identifier (UCID)
A number that uniquely identifies a call in a network of nodes that support 
UCID. This number will be a part of the records in the Call History feature 
of CMS.

User ID
The login ID for a CMS user.

User Permissions
An area of the CMS server that allows the CMS administrator to define 
what each user has access to.

VDN
See Vector Directory Number.

VDN Assignment 
The VDN Assignment Wizard, accessed from CentreVu Framework, 
guides you through the process of assigning a vector and skill preference 
to a VDN. The windows that display after you select Vector Id or Skill Pref 
from the context menu of a VDN object are part of this tool.

VDN Calls-Counted
Also known as counted-calls to VDN and active VDN calls. A Call 
Vectoring capability available with G3V4 or later switches. Counted-calls 
to VDN is a parameter of the go to step and go to vector 
commands that provides conditional branching (to a different step in the 
same vector or to a different vector) based on the number of incoming 
trunk calls a VDN is currently processing.

VDN of Origin  Announcement (VOA)  
A short announcement that is assigned to a VDN through switch  
administration. The VOA identifies the origin or purpose of a call for the  
call center agent who answers the call.
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VDN Skill Preference
Up to three skill(s) can be assigned to a VDN. Calls use VDN skills for 
routing based on your preference (as you administer it in the vector). 
VDN skill preferences are referred to in the vector as “1st,” “2nd,” or “3rd.”

A prioritized list of agent skills administered for a VDN that are required or 
preferred for the answering agent. VDN Skill Preferences represent the 
requirement that a call be routed to an ACD agent with a particular ability 
or set of abilities.

Vector
A list of steps that process calls in a user-defined manner. The steps in a 
vector can send calls to splits, play announcements and music, 
disconnect calls, give calls a busy signal, or route calls to other 
destinations. Calls enter vector processing via VDNs, which may have 
received calls from assigned trunk groups, from other vectors, or from 
extensions connected to the switch.

Vector Command  
A vector step that describes the action to be executed for a call (for  
example, Queue, check, disconnect).

Vector Directory Number (VDN)
An extension number that enables calls to connect to a vector for 
processing. A VDN is not assigned an equipment location. It is assigned 
to a vector. A VDN can connect calls to a vector when the calls arrive 
over an assigned automatic-in trunk group or when calls arrive over a 
dial-repeating (DID) trunk group and the final digits match the VDN. The 
VDN by itself may be dialed to access the vector from any extension 
connected to the switch.

Vector Editor 
This software tool, accessed from CentreVu Framework, allows you to 
create and edit vectors visually, by dragging and dropping icons 
representing commands from a palette and arranging them into vector 
steps in a work area. You can attach comments, change layout, and save 
and print the vectors.

Vector Step
One processing step in a vector. A vector step consists of a command 
and one or more conditions or parameters. These conditions or 
parameters are found on a step's Properties window in Visual Vectors 
client software.
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Vector Step Condition
A condition accompanying a vector command that defines the 
circumstances in which the command will be applied to a call. These 
conditions are found on a step’s properties window in Visual Vectors 
client software.

VOA  
See VDN of Origin Announcement.

Visual Vectors Client 
Client software which provides a rich, graphical user interface for creating 
or modifying configured elements of ACDs connected to a CMS.

Visual Vectors Server 
Server software which enables administration (changing or modifying 
configured elements) for ACDs connected to a CMS.

Voice Terminal
A telephone set, usually with buttons, that gives an agent some control 
over the way calls are handled.

Write Permission
The CMS user can add, modify, or delete data and execute processes. 
Write permission is granted from the User Permissions subsystem.
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